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Welcome to Extensis™ BeyondPress™! BeyondPress is a
powerful Web authoring XTension™ that lets you design full-
featured Web pages in the rich authoring environment of
QuarkXPress®. BeyondPress adds key features to QuarkXPress
for Web authoring including Drag and Drop, hypertext links and
image maps, multimedia, and support for QuickTime movies, Java
applets, and animated GIFs. 

With Beyo n d P re s s , you can use Quark X P ress to cre ate new lay-
outs for your Web page s , or to redesign existing documents, re a r-
ra n ging and adding elements specifi c a l ly for display on the Web.
When yo u ’ve finished designing or re a rra n ging your page s , s i m p ly
d i rect Beyo n d P ress to ex p o rt them as fully functional Web pages. 

Or you can use BeyondPress’s powerful Conversion mode to
convert documents for the Web without changing anything in your
print-ready document. Using Conversion mode you can pick and
choose which text chains and pictures to include on your Web
pages and which to leave out. Or you can combine multiple
document pages into a single Web page.

Whether yo u ’re designing from scrat ch or conve rting existing doc-
u m e n t s , you can prev i ew your wo rk right in your selected Web
B rowe r. Beyo n d P ress shows you file sizes and dowload stat i s t i c s ,
and alerts you to possible conve rsion pro blems. When your design
is complete, B eyo n d P ress ex p o rts the document as HTML Web
p ag s , re a dy for upload and viewing in any browser cap able of dis-
p l aying HTLM files. You can even cre ate your entire Web Site and
test the pages and links befo re you upload to a remote serve r.

System and Software Requirements

To install and use BeyondPress, you will need the following:

M a c i n t o s h :
• Apple® Macintosh® 68040 or faster, including Power

Macintosh and compatibles
•   Mac OS® System 7.5.5 or later 
• Q u a rk X P ress 3.32 or lat e r, 4MB minimum memory part i t i o n
•   HTML Browser for Web page Preview and On-line Help

(Netscape® Communicator™ included). Netscape 4.0 or
Internet Explorer® 4.0 required for viewing DHTML/CSS

• AppleScript® extension for Apple Events (optional)
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Wi n d ow s :
•   Pentium or faster PC
•   Microsoft® Windows 95® or Windows NT® 4.0 
• Q u a rk X P re s s® 4.0.2 or lat e r
•   HTML Browser for Web page Preview and On-line Help

(Netscape® Communicator™ included). Netscape 4.0 or
Internet Explorer® 4.0 required for viewing DHTML/CSS

Installation

Instructions for quick and easy installation can be found on the
CD-ROM that is included with your product.

Registration

It is important to register your copy of BeyondPress so we can
p rovide you with the best possible serv i c e. Regi s t e red users of
BeyondPress a re eligi ble for technical support , i n fo rm ation rega rd-
ing new ve rsions and pro d u c t s , discounts and special offe rs on new
p roducts. 

Your registration number is located on the back cover of this man-
ual. You will need to enter that number to personalize your copy
of BeyondPress. If you choose not to personalize your copy,
BeyondPress will run in a demonstration mode that allows you to
use the product for 30 days. You can purchase additional registra-
tion numbers at 1-800-796-9798.

Technical Support

For questions regarding BeyondPress, please first refer to this
manual, which describes the features and basic operations. We
invite you to visit our BeyondPress page on the Extensis website
(www.extensis.com) for frequently asked questions and trouble-
shooting tips.

If you have a question wh i ch is not add ressed in this manual or
on the Extensis web s i t e, Te chnical Support is ava i l able by phone
at (503) 274-7030, M o n d ay through Fri d ay, 8:00 a.m. to 5:00 p.m.
Pa c i fic time. When calling for technical support, please be at your
computer and have the following information available: your
BeyondPress registration number, your computer configuration,
and your question or a description of the difficulty you’re experi-
encing—what specifically occurs and when. Take note of any dis-
played error numbers or messages and any other information you
think may be relevant.
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Tip

We can also be reached by:

Fax: (503) 274-0530

E-mail: support@extensis.com

I n t e r n e t :
h t t p : / / w w w. e x t e n s i s . c o m / s u p p o r t



Suggestions

We’d love to hear your comments about BeyondPress! For your
convenience, a suggestion sheet is included at the end of this
manual. Please fax, mail, or e-mail your comments and sugges-
tions to Extensis.

What is BeyondPress?

Beyo n d P ress is an XTension to Quark X P ress that allows you to
c re ate page layouts for the Web using the powerful and fa m i l i a r
p age layout tools of Quark X P re s s , then output them as Web page s
without having to manu a l ly code them in HTML. You can eve n
t a ke existing Quark documents used for print and allow Beyo n d-
P ress to conve rt them to HTML. Either way, you can cre ate pro fe s-
sional-looking Web pages that include fo rm atted tex t , i m age map s ,
multiple columns, hy p e rt ext links, GIF and JPEG image s , a n d
multimedia elements like animated GIFs, Java ap p l e t s , and more. 

To cre ate Web page s , you simply select Beyo n d P ress Au t h o ri n g
m o d e, then design your layout in Quark X P ress just as yo u ’d like it
to appear on the Web. Or take an existing document and rewo rk it
so it looks just as yo u ’d like it to appear on the Web. Or even sim-
p l e r, t a ke an existing document just as it is. Then use the Beyo n d-
P ress “ E x p o rt ” function to automat i c a l ly cre ate the necessary
HTML codes and tag s , outputting one Web page for each page in
your document, re a dy to be uploaded to the Web Serve r. And yo u
can use the Beyo n d P ress “ P rev i ew ” fe at u re befo re ex p o rting to see
h ow your Web page will look in the Web Brow s e r, to examine fi l e
s t at i s t i c s , and to identify potential conve rsion pro bl e m s .

When converting certain kinds of documents to the Web you may
want to use BeyondPress Conversion mode instead of Authoring
mode. Conversion mode uses a list paradigm where you choose
which elements of your QuarkXPress print-ready documents you
want placed on your Web pages and which items you want left
off, without affecting your print layout in any way. Conversion
mode also allows you to combine multiple document pages into a
single Web page. When your export list is complete, you use the
BeyondPress Preview and Export functions just as you do in
Authoring mode.

Note: The section “Which Mode—Authoring or Conversion?”
(starting on page 15) will help you determine how best to use
BeyondPress for your particular needs. Tutorial 1 (page 54) and
Tutorial 2 (page 63) describe the WYSIWG Authoring mode;
Tutorial 3 (page 79) describes the list-oriented Conversion mode.
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Feature Summary

• Web Authoring—lets you use the cre at ive and familiar design
tools of Quark X P ress as a powerful WYSIWYG Web author-
ing program to cre at e, m o d i f y, and fo rm at Web pages and page
e l e m e n t s .

• Document Conversion—allows you to convert existing
Q u a rk X P ress documents to Web page s , even adding elements
and re a rraging the layo u t , without ch a n ging anything in yo u r
document. Thus you can retain the integrity of your Quark -
X P ress documents for print while cre ating Web pages from them.

• Export Progress Window—displays download-time at various
bandwidths. File size is reported for HTML text, images, and
media elements.

• Problem report—analyzes the content of a document then lists
elements of the design that can’t be reproduced in HTML.
Double-click the item to go right to it in the document so it can
be fixed quickly.

• Multimedia—lets you add multimedia files including Java
applets, QuickTime movies, animated GIFs, Shockwave and
RealAudio files, with parameters. Macintosh users can view
QuickTime movies and Java applets “live” inside the
QuarkXPress document.

• Attributes Inspector—allows you to quickly configure the
Web attributes of any item on a page (such as formatting,
antialiasing, etc.), or the Web page itself (such as adding a
background image). Default values for all images, media ele-
ments and Web pages can be globally set in BeyondPress
Preferences, then changed on an item-by-item basis. 

• Content List—collects the items to be converted (Conversion
mode). A l l ows you to combine items from diffe rent document
p ages into one Web page, and segment text chains into manage-
able lengths. The Content List is stored with the document so it
can be re - ex p o rted at any time with all fo rm atting ap p l i e d, wh i l e
l e aving the document itself unch a n ged for normal pri n t i n g.

• Image maps—allows you to create links to any page on the
Web, and export in both Client- and Server-side (NCSA or
CERN) formats.

• D rag and Dro p —a dds Drag and Drop cap ability to Quark -
X P re s s , a l l owing you to drag items onto your pages from the
Fi n d e r, the Elements palette, or from other ap p l i c at i o n s .

• Cascading Style Sheets, DHTML/CSS Positioning, Dynamic
Fonts, and Font Face Tags—lets you preserve typography
using Cascading Style Sheets, page layout using DIV tags
(where supported—see sidebar), and font formatting using
Bitstream TrueDoc font technology.
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Note

DHTML/CSS is supported only by
later version browsers such as
Netscape and Internet Explorer
versions 4.0 and above.
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Things to Know About the Web

While Quark X P ress and Beyo n d P ress give you powerful tools to
c re ate stunning and exciting Web page s , t h e Web itself imposes
l i m i t ations on how and wh at you can display. In most cases,
B eyo n d P ress will automat i c a l ly conve rt your page elements to the
ap p ro p ri ate Web fo rm at (according to the settings in Beyo n d P re s s
P re fe rences and any item-by-item ove rri d e s ) , but you should be
awa re of some Web limitations as you design your page s .

• HTML Font limitations: HTML limits the number of font
sizes that can be displayed, and the fonts available on each
user’s system will determine which fonts can be displayed.
BeyondPress converts your non-standard font sizes to Web font
sizes according to the settings in BeyondPress Font Prefer-
ences. For font families, either limit font usage to standard
fonts, or use TrueDoc font technology.

• HTML Layout limitations: Standard HTML provides no abil-
ity to overlap images, lines, or text boxes. You can overcome
this limitation by setting DHTML/CSS positioning in the
BeyondPress Layout Preferences, by grouping elements in
QuarkXPress, or by creating overlapping graphic elements in
another application (like Illustrator or Freehand) and importing
them into your layout.

• HTML Runaround limitations: Standard HTML does not
allow for text runaround. To achieve the effect of runaround
without using DHTML/CSS, anchor picture boxes in text, or
position text and picture boxes so that they do not overlap.

• HTML Rotated or Polygonal item limitations: HTML allows
for only rectangular items. BeyondPress will convert polygonal
and rotated picture boxes to rectangular images using the
“bounding box” of the image. You should convert rotated text
boxes to an image to maintain their appearance .



10

How to Use Your BeyondPress Documentation

BeyondPress provides a number of ways to access valuable infor-
mation about this easy-to-use yet powerful program. Use any or
all of the documentation provided to get up and running quickly
with BeyondPress.

BeyondPress printed User Guide: This document (the one
you’re reading now), contains the following sections:

• Getting Started—gives you an overview of what Beyond Press
can do for you, covers special terms used in the program, and
helps you determine which operating mode, Authoring or
Conversion, is right for the job you need to do.

• Tutorial 1: Creating a Web Page—introduces page setup, Web
page previewing, exporting (converting) your page to HTML,
and the export report.

• Tutorial 2: Building a Web Site—introduces setting up a Web
site, creating templates, creating hypertext links, importing text
and images, and more about exporting.

• Tutorial 3: Using Conversion Mode—shows you how to use
Conversion mode to redesign your QuarkXPress documents for
the Web without affecting the print layout.

• BeyondPress Tools—introduces you to the major tools,
palettes, dialog boxes, and windows that give you access to

BeyondPress’s powerful functions and features.
Use this section as an overview of the available
tools, and as a reference when you want to know
how to access a particular function.

BeyondPress User Guide in PDF format: The
printed user guide in a format which can be
viewed and printed with Adobe® Acrobat®.

BeyondPress Online Reference Guide: Created
as a fully-functioning Web site, the BeyondPress
Online Reference contains a wealth of informa-
tion on all the functions and features available in
BeyondPress. This document expands on the
information in the printed User Guide, adds topics
not covered in the printed User Guide, and pro-
vides step-by-step instructions for the many func-
tions and operations in BeyondPress. 

Use this Online Reference for topics of interest,
and for detailed How-tos on all BeyondPress
operations. And since the Online Reference is a

Tip

The Overview on page 12 and the
section on BeyondPress Tools
(starting on page 18) may be all
you need to get up and running
quickly with BeyondPress. 



complex multi-page Web site designed and created using
QuarkXPress and BeyondPress, you can use it to see how infor-
mation can be communicated using Web pages, how navigation
controls are implemented, as a source for Web page layout ideas,
and more. The complete Site Map for the Online Reference Guide
is given in Appendix C, page 96.

BeyondPress Online Help: BeyondPress Online Help accesses
the BeyondPress Online Reference. By clicking the light bulb
icon found on most BeyondPress palettes and windows,
BeyondPress takes you directly to the section of the Online
Reference pertaining to that palette. This gives you quick access
to the current topic, while also providing access to additional top-
ics of interest.

Additional Sources: For additional information and links to other
sites of interest, visit us at the Extensis Web site:
http://www.extensis.com. 
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Overview

B eyo n d P ress provides two diffe rent modes for cre ating your Web
p age s : Au t h o ring mode and Conve rsion mode. This section give s
you an ove rv i ew of each mode, then discusses Export i n g, t h e
p rocess of outputting your Quark X P ress documents to HTML. 

Generally, if you want to create a Web page layout, or if you want
to change the layout of existing QuarkXPress documents for the
Web by rearranging, adding, or deleting items right in the docu-
ment, and if you want to design and see your Web layout in
WYSIWG fashion, you would choose “Authoring” mode. You
would also choose Authoring mode if you have existing docu-
ments to convert “as-is” into Web pages. You will probably find
that Authoring mode provides everything you need to create and
convert print documents to Web pages, and you will most likely
never use Conversion mode.

But Conversion mode does provide some specialized capabilities.
Conversion mode is a list-oriented mode, where you specify
which text chains (or parts of text chains) and picture elements
from your printed document you want to include on your Web
pages and which you do not. Conversion mode, unlike Authoring
mode, allows you to create a new layout for your Web pages with-
out changing your print-ready documents in any way. Conversion
mode also allows you to combine multiple QuarkXPress pages
into a single Web page, without physically reformatting the
QuarkXPress pages. If you have documents that you want to con-
vert to Web pages by rearranging, adding, or deleting items, or if
you want to combine multiple QuarkXPress pages into a single
Web page, and you want to do this while keeping your
QuarkXPress documents unchanged, you would choose
“Conversion” mode.

The section “Which Mode—Authoring or Conversion?” begin-
ning on page 15 offers additional information to help you deter-
mine wh i ch mode is ap p ro p ri ate for the job you need to do. 

You specify the mode (Au t h o ring or Conve rsion) by cl i cking either
the Au t h o ring tab or the Conve rsion tab on the Document Content
palette [Command+Option+C (Macintosh) or Contro l + A LT + C
( Wi n d ows)]. Each tab makes ava i l able the necessary Beyo n d P re s s
tools for wo rking in the selected mode.

In Authoring Mode, B eyo n d P ress allows you to design Web
p ages the same way you design any other document in

Getting Started with BeyondPress
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Q u a rk X P ress—using Quark ’s own layout and design t o o l s , t y p o-
graphic contro l s , and other pro fessional publishing tools. Au t h o ri n g
mode lets you use Quark X P ress as a WYSIWYG Web Au t h o ri n g
e nv i ro n m e n t — wh at you see on the document page is wh at yo u
will see in the Web brow s e r. Each Quark - X P ress document page is
output as one browser page. The process of designing a page and
exporting it in HTML is covered in the tutorial “Creating a Web
Page” starting on page 54.

You can also use Authoring mode with existing QuarkXPress doc-
uments. Just open them and rearrange the elements on each page
as you want them to look on the Web. Add whatever elements you
want to add for the Web, such as additional images, multimedia
like animated GIFs and JAVA applets—even add your own special
HTML codes. Then Export or Preview as discussed below.

In Conversion Mode, you determine which elements on the print-
ed page you want to include on the Web page. Then, using icons
that represent those page elements, you add them to an export
list. By reordering the elements on the list you specify in precise-
ly what order the elements are added to the Web page. As with
Authoring mode, you can add images, multimedia, and even your
own HTML codes before exporting. We cover the process of con-
verting a document to HTML in the tutorial “Using Conversion
Mode” starting on page 79.

Regardless of which mode you use to create your Web page lay-
out, you can set Preferences that specify the default settings for
your Web site, Web pages, images, fonts, background color and
image, tables, lists, and much much more. You can set defaults
that apply only to specific documents, or that apply to all newly
created documents. And you can override most preferences on an
item-by-item basis.

As you create or prepare your Web pages, you can Preview them
in a browser which you specify, to see exactly how they will look
when viewed on the Web. You can then quickly return to the doc-
ument in QuarkXPress to make desired changes.   

When you are satisfied with your design, you simply export the
document using the Export command on the Document Content
palette. BeyondPress will create Web page (.html) documents
from the QuarkXPress layout, image files (.gif and/or .jpeg) from
your embedded pictures, and media files (.mov, etc.) from your
multimedia files. You can then upload these exported files to your
Web server.
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Te rm s

This manual uses the following terms to describe BeyondPress
features:

• Web Page(s): Page(s) that will be created when you export
your QuarkXPress document, as represented by icons on the
Document Content palette. In Authoring mode, individual Web
pages are represented by page icons. In Conversion mode, indi-
vidual Web pages are represented by folder icons.

• Content List: A list of icons on the Document Content palette in
C o nve rsion mode that rep resent the text ch a i n s , t ext selections,
i m age s , multimedia fi l e s , i n t e ra c t ive fi l e s , and anch o red boxes in
a Quark X P ress document that will be ex p o rted as a Web page.
The list also shows Custom Elements added for ex p o rt (see Cus-
tom Element below ). Each fi rs t - l evel folder on the list rep re s e n t s
a single Web page (other fo l d e rs indicate grouped images). 

• Content Element: An item in the Content List—a text chain,
text selection, image, multimedia file, anchored box, or custom
element.

• Custom Element: An HTML item you create for one-time use
and add to the Content List. Custom Elements are useful for
adding spaces, line breaks, rules, boilerplate text, and your own
HTML-coded items. 

• Master Element: An HTML element (for example, <BR
Clear=Left>) that can be used on multiple Web pages
(Authoring mode) or multiple times in the Content List
(Conversion mode). BeyondPress provides a number of default
Master Elements, and you can add Master Elements of your
own. Master Elements are available to all documents. 

• Master Style: An HTML style tag, similar to a style sheet.
When you create Master Styles they are added to a list of
Master Styles. QuarkXPress style sheets can be mapped to
Master Styles. Master Styles can be applied to text elements in
the Content List and to documents. Master Styles are available
in all documents.

• Meta Tags: Embeded information in the <HEAD> tag of a
Web page used by the site server and by Web search engines
but not displayed on the Web page.

• Shared Image: An image that is used multiple times through-
out a series of Web pages. The first time a browser reads a
shared image, it’s cached on a user’s hard drive and will load
more quickly the next time it is viewed, even if it appears on a
page that has not yet been cached.

Web page—Authoring mode

Web page—Conversion mode
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Which Mode—Authoring or Conversion?

Whether you decide to use WYSIWYG Au t h o ring mode or list-
o riented Conve rsion mode to design and lay out your pages for the
Web will depend on wh at type of task you need to perfo rm. 

Design your pages in QuarkXPress using standard QuarkXPress
layout tools. Then Export using BeyondPress—each page in your
document will be converted to a separate Web page when the doc-
ument is exported.

Open your document(s) and export them using BeyondPress.
Each page in your document will be converted to a separate Web
page document. 

Use Authoring Mode

To create documents 
in QuarkXPress...

... and export them
directly to Web Pages
using BeyondPress

Use Authoring Mode

To convert existing
documents in
QuarkXPress...

... directly to Web Pages
without modifying the
layout

Task 2

Task 1



16

First change the layout of your print documents as you wish them
to appear on the Web page—drag objects into new locations,
resize elements, change the page dimensions, etc. Then Export
using BeyondPress; each page in your document will be convert-
ed to a separate Web page when the document is exported.

Import the images and text that you want to convert into the same
folder on the Document Content palette (Conversion tab). Next,
drag the items on the palette in the order you wish to see them
drawn on the Web page, then Export the folder using
BeyondPress.

Use Authoring Mode

To take existing
QuarkXPress
documents...

... and export them
to Web pages using
BeyondPress

... change the
layout in
QuarkXPress...

Use Conversion Mode

To convert selected
images or text chains in
QuarkXPress documents...

... to a single Web
page using
BeyondPress

Task 3

Task 4
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Import the images and text that you want to convert on the
Document Content palette (Conversion tab), using one folder on
the palette for each separate Web page that you want to create.
Next, drag the items on the folders in the order you wish to see
them drawn on the Web page. Then Export each folder of items as
a separate Web page.

Import all the images and text chains into the same folder on the
Document Content palette (Conversion tab), then Export the
folder as a Web page.

Use Conversion Mode

To convert selected
images or text chains in
QuarkXPress documents...

... to a series of
Web pages using
BeyondPress

Use Conversion Mode

To convert a multi-page
QuarkXPress document...

... to a single Web
page using
BeyondPress

Task 5

Task 6



Document Content Palette

The Document Content Palette allows you to select either W Y S I-
WYG Au t h o ring mode—wh e re you can cre ate HTML Web page s
t h at look ex a c t ly like your Quark X P ress document, or list-ori e n t e d
C o nve rsion mode—wh e re you can conve rt  selected text ch a i n s ,
p i c t u re boxe s , and other objects into Web page s .

To access the Document Content palette: Select Extensis >
B eyo n d P ress > Show Document Content. Or pre s s
Command+Option+C (Macintosh) or Control+Alt+C (Wi n d ow s ) .

Au t h o ring Mode: In Au t h o ring mode the Document Content
palette displays each page in the document as an icon; each icon
rep resents a sep a rate Web page. Doubl e - cl i ck a page icon to nav i-
gate to that page in Quark X P ress. Use Au t h o ring mode to design
Web pages just as you do other types of documents. In Au t h o ri n g
mode you can add image s , t ex t , and multimedia elements, e s t ab-
lish default pre fe rences for fo rm atting and ex p o rt i n g, and cre at e
hy p e rlinks and image map s .

C o nve rsion Mode: In Conve rsion mode you cre ate a Content List
t h at displays the tex t , i m age, multimedia and HTML elements of
an existing Quark X P ress document as icons. On the Content List,
e a ch Web page is indicated by a folder icon. To the right of each
list element icon (in the HTML c o l u m n ) , a “ M o d i f y ” pop-up menu
lets you manipulate and prep a re elements in your document fo r
c o nve rsion to Web fo rm ats. 
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BeyondPress Tools

The document Content palette provides
access to Authoring Mode and
Conversion Mode tabs.

A Authoring Mode tab: Contains options
for creating web pages that preserve
the layout of your QuarkXPress docu -
ments. See page 19.

B Conversion Mode tab: Contains
options for converting selected items
from a QuarkXPress document to
Web pages. See page 21.

C Current Page Arrow: Indicates the
page within the document that you’re
currently viewing in QuarkXPress.

D Help: Opens Online Help for the
active item using the currently select-
ed Web browser.

D

C

BA

Document Content Palette

Tip

For help determining which mode
is appropriate for the job you need
to do, see “Which Mode—Author-
ing or Conversion?” starting on
page 15.

QuarkXPress version 3.32 Users:
All BeyondPress palettes are avail -
able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.



Authoring Mode

Selecting the Au t h o ring tab on the Document Content palette
a l l ows you to add, m o d i f y, and fo rm at the basic elements of yo u r
Web page using Quark X P re s s , then ex p o rt those pages in HTML
fo rm at as a Web page. See page 21 for Conve rsion Mode options.

To access Au t h o ring mode: Select Extensis > B eyo n d P ress > Show
Document Content. Or press Command+Option+C
(Macintosh) or Control+Alt+C (Windows). Click the
Authoring tab.

Note: QuarkXPress v3.32 users access the Document
Content palette from the View menu.
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The Authoring tab contains options for
creating web pages using the WYSIWYG
layout capabilities of QuarkXPress.

A Attributes Inspector: Select the
element on the page you want to
modify, then click this icon.Options
you can modify include: Text, image,
web page, HTML, and multimedia
preferences. Also allows you to
override Preferences for individual
elements.

B Page: Lists each page in the docu-
ment as a separate icon. Arrow indi-
cates the currently active page in
QuarkXPress. Double-click a page
icon to make it the active page.
Pages are shown by number unless
the page is named. Click in the num-
ber field to enter a name for the page
(see page 76).

C Link: Create a hyperlink to a URL,
another page in the same document,
or another page in your Web site
(see page 32).

D Preview: Displays the selected docu-
ment as it will appear when exported,
using the indicated Web browser.

E Export: Exports the selected page in
H T M L format. Click and hold to
access the Export A s. . . pop-up menu.

F Preferences: Displays the Beyond
Press Preferences dialog ( s e e
page 36).

G Help: Opens Online Help in the cur-
rently selected Web Browser.

GA

B

C D E F

Document Content Palette—Authoring tab



Layout Considerations 

BeyondPress approximates the layout of QuarkXPress documents
using HTML  tables. Because of the the limitations of HTML,
some layouts cannot be exactly reproduced.

Before you begin designing pages, keep the following in mind:

Unless you enable DHTML/CSS Positioning, items cannot over-
lap in a QuarkXPress document because standard HTML does not
allow overlapping text, images, or lines. BeyondPress by default
enables DHTML/CSS Positioning. If you choose to disable this
option (see page 40) and overlap text, images, and/or lines, you
will get a warning message in the Export Progress Window when
you export the document to HTML. 

Images overlapping images: Separate image items and lines so
that they do not overlap, or group them together and have
BeyondPress to export the group as a single image.

Images overlapping text: Standard HTML does not provide
runaround of items as QuarkXPress does. If you are not using
DHTML/CSS, you should anchor image boxes in text, or move
them so they do not overlap text. 

Text overlapping images: You can group text boxes with images
and tell BeyondPress to export the group as a single image.

Rotated items and irregularly shaped boxes: Standard HTML
allows for only rectangular-shaped items. BeyondPress will con-
vert polygonal image boxes and rotated images to rectangular
images using the “bounding box” of the item. Keep in mind that
although two rotated or polygonal items in QuarkXPress may not
overlap, their bounding boxes may overlap. You should convert
rotated text boxes to an image to maintain their appearance.

20
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Conversion Mode

Selecting the Conve rsion tab on the Document Content palette
a l l ows you to select individual text and image elements of ex i s t i n g
Q u a rk X P ress document and re fo rm at and re o rder them without
ch a n ging the document. The text and images become You can also
a dd multimedia and prev i o u s ly cre ated HTML items to yo u r
p ages. See page 19 for Au t h o ring Mode options.

Icons rep resenting the contents of your Quark X P ress document are
listed on the Content List in the Conve rsion tab. By manipulat i n g
the elements in the list, you specify pre c i s e ly wh at is ex p o rted to
HTML and how it should look on the Web page.

The Conversion tab provides options for
reformatting Web pages from Quark-
XPress documents without affecting the
layout of the original document. 

A New Web Page: Click to add a new
Web page folder to the Document
Content List.

B List Document:Click to add all items
in the document to the Content List.

C Add Items:Click to add the currently
selected item(s) to the Content List.  

D Add Text:Click to add highlighted text
(and its box) to the Content List.
Create a text range.

E Link: Create a hyperlink to a URL,
another page in the same document,
or another page in your Web site.

F Segment Text Chain: Click to divide a
text chain for export to different Web
pages.

G Preview: Click to preview the selected
Web page or element in the specified
browser.

H Preferences: Click to display the
Preferences dialog box.

I Delete: Click to delete selected
item(s) from theContent List.

J Web Page Folder: Lists all the ele-
ments from the current QuarkXPRess
document that will  be included on the
Web page when the document is
exported. 

K Image Icon

L Grouped Image Icon

M Document Content List

N Help:Access Online Help.     

N

J

K

L

M

A

B

C

D

E

F

G

H

I

Document Content Palette—Conversion tab
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Working with the Content List

In Conversion mode, when the Document Content palette is the
active window a border surrounds the Content List and a number
of keyboard commands are made available. Keyboard commands
are listed in Appendix A, page 93.

Rearranging Elements 

To rearrange elements in a Web page, drag the corresponding
icons to the correct position in the Content List. 
• Text Chains and Images can be rearranged and dragged into

different Web page folders. The contents of each folder will be
exported as a single Web page. To place items on the same
Web page, make sure they are in the same folder.

• Images can be rearranged and dragged on top of Text Chains
to anchor them in text.  

• Tables and Lists that are not part of a larger Text Chain can
also be rearranged.

• Text Ranges, Anchored Text, and Anchored Images are dis-
played in gray because they cannot be moved using the palette.
To change the position of these elements, the original content
must be rearranged in the document Tables and Lists that are
part of a larger Text Chain cannot be moved.

Renaming Elements 

To rename an element in the Content List, click the text to high-
light it, then enter a new name using up to 64 characters. Here's
how elements are named by default:

• Web pages are named "Untitled Web Page" until renamed.
• Text elements are named using the fi rst 64 ch a ra c t e rs in the story.
• Image elements are named using the image file names; "xxx"

if the image has no associated file; or "Empty Picture Box" if
there is no image in the box. 

Tip

You can easily delete items from
the Content List—simply select
them, then drag and drop them
over the Trash icon, or press the
Delete key.



The Shared Elements Palette

Available in both Authoring mode and Conversion mode, the
Shared Elements palette contains three tabs: Images, HTML, and
Media. Elements listed in the Image and Media tabs correspond to
files in specific locations on your Web server or hard drive, as
specified in Site Preferences. Use the Image and Media tabs to
add shared elements from your Web site folders. Use the HTML
tab to add Custom and Master HTML items to your Web pages.

To access the Shared Elements palette: Select Extensis >
B eyo n d P ress > S h ow Shared Elements. Or pre s s
C o m m a n d + C o n t rol+S (Macintosh) or Contro l + S h i f t + S
( Wi n d ows). 
The Images, HTML, and Media tabs of the Shared elements
palette are described on the following pages.
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Icon/Element Name Meaning HTML Options

Web page Contains elements  Export, Export As, Modify  

Text Chain Text from linked boxes HTML pop-up menu 

Text Range Text isolated from a chain HTML pop-up menu 

Text Segment Text separated from a chain HTML pop-up menu 

Anchored Text Text box anchored in text HTML pop-up menu 

Table Text formatted as a Table Modify, As Text 

List Text formatted as a List Modify, As Text 

Images Image Modify, displays Image Settings 

Anchored Image Image anchored in text Modify, displays Image Settings 

Group Image Group of QuarkXPress items Modify, displays, Image Settings

Conversion mode icons
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Image: By clicking the Locate Folder button on the Image tab
and selecting the folder t h at contains your Web page image s , a n
i m age list is cre ated in the Image tab. To place image s , d rag them
f rom the Image tab onto a Quark X P ress page. Eve ry time yo u
ex p o rt pages containing images that yo u ’ve designated as share d
i m ages (using the A t t ri butes Inspector) the names of those image s
a re added to this list and become ava i l able for use on other Web
p ages. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
I m age : A dding Images to Web Page s .

A Elements Palette Title Bar

B Image tab 

C Locate Folder: Click to select the
folder containing your Web page
elements and display them on the
Image List.  

D Image List: Drag images from the list
into your document. 

E Parent Application: Double-click an
image icon on the list to open the
image in the parent application.

F Help: Access Online Help.

FC

D

E

B

Shared Elements Palette—Image tab

A
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H T M L : The HTML t ab allows you to add Custom and Master
HTML items to your Web pages. Seven default HTML items are
p rov i d e d. Two additional icons (indicated by a question mark )
a l l ow you to add Custom HTML elements and to import Master
Elements from other documents.  

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
Links and Image Map s : C re ating a Link within a Web Page and
C re ating Hypert ext Links and Image Maps. 

A HTMLtab

B HTMLElements icons: Lists available
HTMLelements [(C) through (M)]. In
Authoring mode, drag an element
(such as Date (J) or Time (K)) onto a
document page to add it to the Web
page. In Conversion mode, drag the
indicated element from the button bar
to the Document Content palette’s
Content List to add it to the Web
page.

C Custom: Allows you to create your
own Master HTMLelements.

D Custom Elements List: Drag an the
Custom Elements (C) to this list to
create a new HTMLelement. To use
it, drag it to the document or Content
list (see (B) above.) 

E Sample Custom Element: “Footer”
Master Element (shown) was created
by dragging the Custom icon onto the
list, then filling in the Name and
HTMLtext. <HR> is the HTMLtag for
a footer, “Last updated on: “ is the
text that will appear in the footer, and
{Date} is an embedded element that
will insert the date after the text. 

F Paragraph: Paragraph return (Return in
QuarkXPress, <P> in HTML).

G Line Break:Line break character
(Shift+Return in QuarkXPress, <BR>
in HTML).

H Space:Space character.

I Horizontal Rule: Horizontal rule.

J Date: Export date as specified in
Export Preferences.

K Time:Export time as specified in
Export Preferences.

L Delete: Delete the selected element
from the list.

M Import Master Elements: Import Mast-
er Elements from other Web pages. 

N Help: Access Online Help.

N
C
B

D

A

Shared Elements Palette—HTML tab

F G H I J K L M

E

Tip

You can insert existing Master
Elements into your Custom HTML
text by including the element
name between curly brackets:
{ M a s t e r E l e m e n t } .
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M e d i a : By cl i cking Locate Folder on the Media tab and selecting
the folder that contains your Web page media fi l e s , a media file list
is cre at e d. To place media files in your document, d rag them fro m
the Image tab onto a Quark X P ress page. Once media files are
a dded to the list, t h ey become Shared Images. The types of media
files ava i l able in the list are determined by Media Pre fe re n c e s .

Macintosh only : By ch e cking “ L ive Display,” files added to Web
p ages from the Media tab will “ p l ay ” on the Quark X P ress page. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
A dding Multimedia to Web Pages. See also Beyo n d P ress Online
R e fe re n c e : Site Map : Fe at u re s : Media Pre fe re n c e s .

A Elements Palette Title Bar

B Media tab 

C Live Display: Click to allows media
files to play on the QuarkXPress
page.

D Select Folder: Click to select the
folder containing your Web page
elements and display them on the
Image List.

E Animated GIF Image Icon 

F QuickTime Movie Icon 

G Parent Application:Double-click a
media item to open it in the parent
application. (An animated GIF from
Extensis PhotoAnimator is shown.)

H Help: Access Online Help.

Shared Elements Palette—Media tab

HD

E

C

F

B
A

G



Attributes Inspector

The A t t ri butes Inspector functions in Au t h o ring mode to let yo u
ove rride the document-wide default Pre fe rences settings for indi-
vidual items or pages. From the A t t ri butes Inspector you can
ch a n ge the default settings sep a rat e ly for text ch a i n s , i m age s ,

p age s , and multimedia elements.

To access the A t t ri butes Inspector: With Au t h o ring mode
s e l e c t e d, select an item and cl i ck the Inspector button on the
Document Content Au t h o ring tab. Or press Command+
C o n t rol+M (Macintosh) or Control+Shift+M (Wi n d ows). 

Web Page Settings: To access Web Page Settings, cl i ck the
A t t ri butes Inspector with no items selected (cl i ck in the pasteb o a rd
or in the white space between text and picture boxes to deselect all
items). Settings specified here will ove rride the Default Web Page
P re fe rences for a specific page when the “Use Defa u l t s ” b ox is
u n ch e cke d. Settings indicated in the Web Page Settings window
ap p ly to the page whose number is displayed in the lower left cor-
ner of the Quark X P ress document window. 
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Web Page Settings override the Default
Web Page Preferences for a specific page
when “Use Defaults” (B) is unchecked.

A Color Selection: Click the color box to
access the system color palette and
select a color for the indicated item.

B Use Defaults Selection Box: When
Unchecked, allows the indicated
settings to override the document-
wide default Web Page Settings.
When Checked, disables all settings
in this window and forces the
document-wide defaults to be used.

C Color Controls: A checkmark in the
box allows the indicated color to over-
ride the document-wide default set -
ting, if and only if the “Use Defaults”
box is unchecked.

D Background Image Controls: Allows
you to specify a background image to
be tiled. These pop-up menus contain
whatever Master Elements you have
added using the Shared Elements
Palette.

E Format Controls: Specify Meta Tags,
Header, and Footer options. Contains
Master Elements you added using
the Shared Elements palette.

F Help:Access online Help.

E

A

Attributes Inspector—Web Page Settings

B

C

D

F

QuarkXPress version 3.32 Users:
All BeyondPress palettes are avail-
able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.
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I m age Settings: When you cl i ck the A t t ri butes Inspector and
select a picture box , the Image Settings window is displaye d. Th i s
w i n d ow is also displayed when you select an animated GIF fi l e
t h at you cre ated on the Media tab of the Shared Elements palette.
Use Image Settings to ove rride Image Pre fe rences for a specifi c
i m age.

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
I m age. See also Site Map : Fe at u re s : A t t ri butes Inspector: I m age
Settings of the A t t ri butes Inspector.

Image Settings override document-wide
Image Preferences for the selected image.

A Copy Original: Places a copy of the
original GIF or JPEG image into the
images folder on export (rather than
having BeyondPress convert the
image.)

B Image Formatting options: 

Format: GIF, JPEG, or Default.
Interlaced: On (interlaced), Off

(progressive), or Default.
Palette: System Palette, Adaptive, or

Default
Antialias:On, Off, or Default

Share This Image: Yes (checked),
No (unchecked), or Default.

Alt: Enter text to be displayed when
the image file fails to download.

Extra Image HTML: Append
additional image tags. If Copy
Original (A) is enabled you must
manually include the width and
height tags.

Alignment: Top, Middle, Bottom, Left,
Center, Right, or Default.

C Image Map and Transparency options.
See BeyondPress Online Reference:
Features:Attributes Inspector: Image
Settings.

D Image: Image displayed at full size.

E Link Indicator: Indicates that a link has
been set on this image. Multiple links
can be set. When the link is selected,
the following options become avail -
able:Delete, Forward, Backward.

F Help: Access Online Help.

Image Map and Transparency Tools

G Selection tool

H Bucket tool

I Eyedropper tool

J Rectangular Link tool

K Circular Link tool

D

A

D E

Attributes Inspector—Image Settings

B

C

G H I J K

Tip

You cannot crop or scale an image
from the Inspector in A u t h o r i n g
mode. Crop and scale your images
in the QuarkXPress document.
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Text Box Settings: By cl i cking the A t t ri butes Inspector and select-
ing a text box , Text Box Settings will be displaye d. Use Text Box
Settings to conve rt tex t , s u ch as a logo , to an image. When yo u
c o nve rt text to an image, you can select image fo rm ats and modifi-
c ations including antialiasing, o p t i m i zed color palettes, t ra n s p a re n-
cy, i m age map s , Alt tag s , and Extra Image HTML.

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
Text. See also Site Map : Fe at u re s : A t t ri butes Inspector: Text Box
Settings of the A t t ri butes Inspector.

Text Box Settings allow you to convert
text—such as a logo—to an image, then
apply image formatting and modifications.

A As Image: When Checked, converts
the selected text to an image. When
Unchecked, disables all settings in
this window and keeps text as text. 

B Name: Enter a name for the exported
image.

C Help: Access Online Help.

D Image Formatting: Change settings
for the indicated image formatting
options (see page xx for details).

E Image Map and Transparency:
Access image transparency and
mapping (link) tools: Selection tool,
Bucket tool, Eyedropper tool,
Rectangular Link tool, and Circular
Link tool.

F Image Preview 

A B C

Attributes Inspector—Text Box Settings

D

E

F



Applet Settings: By cl i cking the A t t ri butes Inspector and selecting
a Java Applet or other Applet media item, Applet Settings will be
d i s p l aye d. Use Applet Settings to ove rride Media Pre fe rences for a
s p e c i fic Applet. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
M u l t i m e d i a : A dding Multimedia to Web pages and Setting Media
P re fe rences. See also Site Map : Fe at u re s : A t t ri butes Inspector:
Applet Settings of the A t t ri butes Inspector.
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Applet Settings allow you to override
Media Preferences for a specific Applet. 

A Code: Displays file path to the file
containing the Applet code.

B Name: Allows you to type in a custom
name for the Applet.

C Parameter Name and Value Fields:
Allows you to define specific parame-
ters and behaviors for the Applet
being inspected.

D Examples of Applet parameters.

E Alternate HTML: Allows you to type in
additional HTMLcode to add other
Java behaviors for the Applet being
inspected.

F Help: Access Online Help. 

G Alt: Lets you type in alternate HTML
text that will appear on the web page
of the Applet fails to load.

H New: Click to add a new parameter to
the Applet being inspected.

I Delete: Click to delete the selected
Applet parameter.

Attributes Inspector—Applet Settings

H

E

A

B

C
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F
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Embed Settings: By cl i cking the A t t ri butes Inspector and select-
ing a Quick Ti m e, S h o ck wave, R e a l Au d i o , P D F, V R M L , M I D I
a u d i o , WAV audio fi l e, or other embedded media item, E m b e d
Settings will be displaye d. Beyo n d P ress uses the Embed HTML
t ag to place these files in HTML. Use Embed Settings to ove rri d e
Media Pre fe rences for a specific fi l e.

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
M u l t i m e d i a : A dding Multimedia to Web pages and Setting Media
P re fe rences. See also Site Map : Fe at u re s : A t t ri butes Inspector:
Embed Settings of the A t t ri butes Inspector.

Embed Settings allow you to override
Media Preferences for a particular movie,
animated GIF, etc. 

A Code: Displays file path to the media
file being inspected. Click to choose a
different file.

B Parameter Name and Value: Allows
you to define specific parameters and
behaviors for the media file, such as
LOOP=TRUE for a QuickTime movie.

C Examples of media parameters and
values.

D Alternate HTML: Allows you to type in
additional HTMLcode to add other
Java behaviors that will be triggered
when the media file is displayed.

E Help: Access Online Help. 

F New: Click to add a new parameter to
the item being inspected.

G Delete: Click to delete the selected
parameter.

Attributes Inspector—Embed Settings

F

D

A
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Link Editor

Hyperlinks within a Web page or group of Web pages let you cre-
ate jumps to different areas—for example, from a thumbnail to an
image, from a word to a definition, or from a table of contents to
a story. You access the Link Editor by selecting the text or ele-
ment you wish to link and clicking the Link icon on the
Document Content palette (see page 19).

See Beyo n d P ress Online R e fe re n c e : Site Map : Web Au t h o ri n g :
Links and Image Map s : C re ating a Link within a Web Page and
C re ating Hypert ext Links and Image Maps. See also Site Map :
Web Au t h o ri n g : Tex t : Link Text A t t ri bu t e s .
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The Link Editor allows you to set hyper-
text links between text and images either
in the document (on the same Web page)
or External (on a different Web page).

Within Document

A Link Source: Text or image you are
linking from.

B Target Window: Allows you to specify
the frame or window in which the link
being created will open. Example:
Choosing “New” from the pop-up
menu will cause the link to open in a
new window in the browser.

C Extra Link HTML: Allows you to manu-
ally enter HTML links to JavaScripts to
enable specific Java behaviors. For
example, by adding an “onMouseOver
=function” to this field, the link can be
used to trigger a JavaScript whenever
a user points to the link in a browser.

D OK: Until the “link to” has been set, this
button will be dimmed. After the link
has been set, click here to set the link.

E Cancel: Click to close the Link Editor
without making any changes

E x t e rn a l

F Link: Enter a URLto specify the des-
tination of the link being edited, or
choose a URLfrom the pop-up menu.
The pop-up menu stores the 40 most
recently added links.

G Copy From Browser: Copies the URL
from the page currently being viewed
in the browser to the link field. Use to
enter URLrather than typing it in.

Locate File: Click to link to an HTML
file on your hard drive or file server.

Link Editor

G

A

C
B

F

D E
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Export Progress Window

When you export a QuarkXPress document to HTML, the Export
Progress window displays, showing Web page statistics and any
problems there may be with exporting the document.

To display the exported page in a preferred browser, click Open
in Browser. Check Automatically to always open exported pages
in a browser. To collapse the window, click the triangle next to
Statistics and/or Problems.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s : E x p o rt
P rogress Wi n d ow. 

Export Progress window displays Web
page statistics and any problems or
potential problems encountered during
the export to process.

A Export Progress Title Bar

B Exported From/To: Displays the
exported Web page name (as speci-
fied on the Page List in the Authoring
tab of the Document Content palette),
and the name of the HTMLdocument
created from it.

C Open in Browser: When “Automatic-
ally” is checked, opens the exported
Web page in the selected browser
automatically when the export is
complete. When Unchecked, click the
“Open in Browser” to display the
page in the selected browser.

D Statistics: Displays estimated
download times and file size
information for the exported files.

E Problems: Displays problems and
potential problems encountered dur-
ing the export process, and their
severity.

F Help:Access Online Help.

G Fatal Error:Indicates that a Fatal
error was encountered. The Web
page could not be exported.See page
34 for a list of Fatal Errors.

H Non-fatal Error: Indicates that a Non-
fatal error occurred. The Web page
export was completed. See page 35
for a list of Non-fatal Errors.

I Text Error: A text error occurred, but it
was not severe enough to prevent the
document from exporting. See
page 35 for a list of Text Errors.

F
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Error Messages

There are three types of export error messages. Double-click an
error icon to highlight the problem item in the QuarkXPress
document.

Export Error Messages

There are three types of errors displayed in the Export Progress
Window—Stop, Warning, and Note. By double-clicking an indi-
vidual error message, the QuarkXPress item(s) causing the error
will be displayed. The various types of errors are listed below.

Stop sign

A “fatal” error occurred. The Web page could not be exported.

When a “fatal” error is encountered:

1. A dialog appears with the error message (such as “Out
of memory (-108)” or “File not found (-43),” etc.).

2. The progress bar is replaced with a text message that
says “An error occurred during export” (but does not
contain the error message).

3. A “stop sign” error appears in the list with one of the
messages below. Double-click the message to display the
QuarkXPress item causing the error.

• Error encountered while exporting an image.

• Error encountered while exporting a box.

• Error encountered while exporting some text.

• Error encountered while exporting a content list item.

• Error encountered while exporting Web page background
image.

• Error encountered at unknown location during export.

If one of the following errors appears, please contact
Extensis Technical Support:

• Internal Error

• Internal Error - Unknown Tree Element

• Internal Error - Unknown Box Type

• Internal Error - Bad Hidden Text Version
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Warning sign 

A non-fatal error occurre d, but the Web page could still be ex p o rt e d.

• Overlapping boxes will produce unpredictable results.
• Text box angle, skew, or flip will not be retained in HTML

unless set to ‘As Image.’
• This document contains fonts which cannot be recorded by

TrueDoc.
• Some fonts could not have TrueDoc work. 
• Non-rectangular boxes will be converted to rectangular in

HTML.
• Text runaround cannot be preserved in HTML 

Note icon 

An error occurred, but the Web page could still be exported. All
note errors address problems with text.

• Justified text will be output as left-aligned in HTML.
• Drop Cap formatting will not be retained in HTML.
• Outline and Shadow text styles cannot be retained in HTML.
• Horizontal or Vertical text scaling cannot be retained in HTML.
• Kerning and/or Tracking cannot be retained in HTML.
• Baseline Shift cannot be retained in HTML.
• Small Caps text format cannot be retained in HTML.
• H&J optimal spacing settings in text cannot be retained in

HTML.
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P re f e re n c e s

BeyondPress Preferences let you customize each page element for
export to HTML. Preferences control the default formatting,
layout, and naming conventions of pages, text, images, and media
files.

BeyondPress Preferences are contained in one multi-paneled
(Macintosh) or tabbed (Windows) dialog box, in which each panel
or tab contains a different set of preferences (for example: Export,
Image, Mapping, and Linking). You can set all your initial
Preferences (default values) at once, then go back to a specific
panel as needed. BeyondPress Preferences are saved with each
document so you can customize settings by Web site, or even by
Web page.

As with QuarkXPress, preference settings that you make when no
documents are open apply to all documents. You can also import
settings from other pages or revert to Default settings.

Setting Preferences

Open the Preferences dialog box by clicking Preferences 
on the BeyondPress palette (Authoring or Conversion
Mode), or by choosing Extensis > BeyondPress >
Preferences, or press Command+Control+Y (Macintosh) or
Control+Alt+Y (Windows). 

The Preferences dialog box has the following characteristics:

• Clicking an icon in the left column (Macintosh) or clicking a
tab (Windows) specifies which of the 13 preference panels to
display.

• The “Revert Panel” button affects only the current panel. 
• A “Factory,” “Import,” or “Append” button on each panel lets

you use preferences from another source. See “Importing or
Appending BeyondPress Preferences” on page 37.

• The “OK” and “Cancel” buttons accept or reject changes made
to all panels in the BeyondPress Preferences dialog box. 

• Clicking the Help icon in the upper right corner of any
Preferences pane displays the corresponding page from the
BeyondPress Online Reference to assist you in setting the vari-
ous preferences.

Tip

To quickly open the BeyondPress
Preferences, press Command+
Control+Y (Macintosh) or
Control+Alt+Y (Windows).

QuarkXPress version 3.32 Users:
BeyondPress Preferences are
available from the Edit menu.
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Importing or Appending BeyondPress Preferences

Depending on the type of information in a Preferences panel, you
can either import or append preferences from another source.

• The Import button (in the Export, Layout, Web Page, Font
Names, Site, Image, Table, and List panels) lets you import
preferences from another document for the current panel.
Imported preferences replace the existing preferences.

• The Append button (in the Mapping and Styles panels) lets you
add style sheet mapping and Master Styles to the current panel.
Appended items are added to existing items in the list.

Note: To append style sheet mapping, append any Master Styles
used in the mapping first. If you append Master Styles with the
same name as those in your list, a dialog box is displayed
allowing you to rename the appended Master Styles. 

• The Factory button on the Application panel lets you import the
preference settings that ship with BeyondPress.

You can import or append preferences from:
• Another document that you have prepared for export with

BeyondPress.
• Default Preferences, which are the defaults you set when no

documents are open.
• Factory Preferences, which are the preference settings that ship

with BeyondPress. 

Saving BeyondPress Preferences

BeyondPress Preferences are saved as follows:

• When you modify BeyondPress Preferences without a docu-
ment open, you are creating your Default Preferences. The
Default Preferences are saved in the BeyondPress Preferences
file in your System Folder. You can share your BeyondPress
Preferences file with other BeyondPress users to ensure the
same defaults. Default Preferences are used for all new Web
pages created in Authoring Mode and documents whose con-
tents have not been listed by BeyondPress in Conversion Mode.

• Most preferences in BeyondPress are document-specific. If
you change any of these preferences while a document is open,
they are stored with the document itself. Other preferences
(Application and Media preferences, for example) are
application-specific. These are saved in the BeyondPress
Preferences file.

Tip

You can automatically import and
append preferences for all the tabs
in one step by Option-clicking
(Macintosh) or Right-clicking
(Windows) an “Import” or “Append”
button.
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Application Preferences

Use Application Preferences to set Apple Events defaults, to
control how BeyondPress lists and converts page elements in
Conversion Mode, and to specify which HTML browser or
application (such as SimpleText) will be used to Preview and
view pages after they have been exported.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Ap p l i c ation Pre fe re n c e s .

A Application Preferences Icon.  

B Help: Opens Online Help in the cur-
rently selected Web Browser.

C Apple Events: Options are: Use
Scripts Menu or Recordability. See
“Apple Events Support”in the Online
Reference.

D List Document: Options are: Ignore
empty Boxes, Ignore Unchanged
Master Items, Auto Anchor Images,
and Auto Create Tables.

E HTMLBrowser: Allows you to specify
which browser or application to use
for previewing pages and Online
Help. See “Apple Events Support”in
the Online Reference.

F Factory: Allows you to import the
preference settings that ship with
BeyondPress. Factory preferences
replace the existing preferences on
the current panel.

G Revert Panel: Restores panel to the
last-saved settings.

H Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

I OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.
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Application Preferences
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Export Preferences

Use Export Preferences to control how Web pages and type are
exported to HTML files, how date and time are displayed, and
where Unshared Web Page Elements are stored.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : E x p o rt Pre fe re n c e s .

A Export Preferences Icon

B Create Relative URLs: Creates links
to files within your own Web site with-
out specifying a complete file path, so
that the links will function correctly
when uploaded to a file server.

C Readable HTML: Adds carriage returns
in exported HTML so that the HTML
source code is easier to read and edit.

D Help: Opens Online Help in the cur-
rently selected Web browser.

E Text Formatting: Options are: Cas -
cading Style Sheets, Convert Bold &
Italic Fonts, Convert Paragraph to
(Default, <P>, <DIV>), Font Name
Tags, TrueDoc Fonts, Text Color.

F Date and Time: Lets you select the
form in which Date and Time are dis-
played on the page. Date and Time
are inserted on the page in the loca-
tion specified in the Date and Time
Master Elements.

G Destination Platform: Allows you to
select the platform where your web
pages will be displayed. Options are:
Macintosh (CR), DOS/Win (CR/LF),
Win 95 (CR/LF), or Unix (LF).

H Unshared Elements: Determines
where within your site folder exported
H T M L and graphics files are stored.
Options are: Web Page Folder, Com-
mon Web Page Subfolder, and Sub-
folder Based on Web Page Name. 

I Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref -
erences on the current panel.

J Revert Panel: Restores panel to the
last-saved settings.

K Cancel: Closes Preferences without
making changes to any of the panels.

L OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.
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Layout Preferences 

Use the Layout Pre fe rences to control how Web pages are viewe d
in browser ap p l i c ations. These pre fe rences are applied while wo rk-
ing in Au t h o ring Mode. Beyo n d P ress uses either automatic tabl e
c re ation or DHTML/CSS Positioning to ap p rox i m ate the layout of
your page s , and adds alignment and width at t ri butes to the Tabl e
H T M L t ags to position pages according to your pre fe re n c e. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : L ayout Pre fe rences. See also BeyondPress Online
Reference: Web Authoring: Layout.

A Layout Preferences Icon: Control the
alignment of Web pages as displayed
in a browser window.

B Help: Opens Online Help in the cur-
rently selected Web Browser.

C DHTML/CSS Positioning: Controls
whether the layout will be maintained
using DHTML/CSS positioning.
DHTML/CSS are supported only by
Netscape and Internet Explorer
browser versions 4.0 and above.

D Alignment: Controls the horizontal
position of Web pages as the layout
is displayed in a browser. Options
are: Standard, Left, Center, or Right.
Standard adds no alignment attribute
and by default is left-aligned.

E Maximum Width: Controls how Web
pages are drawn horizontally by a
browser.

“Browser Determined” lets Web
pages fill the full width of the browser
window.

“Width of Document Items” keeps We b
page width to the size given in the
QuarkXPress document, regardless of
browser window size. 

“ Va l u e : ” (specify value) lets you assign
a specific page width in points (pixels)
regardless of browser window size.

F Don’t Allow Boxes to Shrink:
Checking this box create Web pages
no smaller than the objects on them.
Page items will be placed no closer
than they are in the QuarkXPress
document regardless of browser
window size.

G Import: Allows you to import settings from another document. Imported prefer-
ences replace the existing preferences on the current panel.

H Revert Panel: Restores panel to the last-saved settings.

I Cancel: Closes the Preferences dialog box without making changes to any of the
p a n e l s .

J OK: Applies indicated changes on all Preference panels and closes the
Preferences dialog box.
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Web Page Preferences 

Use the Web Page Preferences to control the basic look of your
Web page by adding background and link colors, headers, footers,
and Meta Tags.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Web Page Pre fe re n c e s .

A Web Page Preferences Icon: Control
the basic look of your Web page by
adding background and link colors,
headers, footers, and Meta Tags.

B Colors: Select color for Text, Links,
Visited Links, Active Link, and Back-
ground. Click the box to activate the
desired item(s). Click the color box to
access the system color picker and
select a color for the indicated item.

C Help: Opens Online Help in the
currently selected Web Browser.

D Meta Tags: Allows you to embed
information in the <HEAD> tag of a
Web page. This information is used
by the Server and Web search
engines but is not displayed on the
Web page. Options are: C r e a t i o n
Date, Horizontal Rule, Line Break,
Margin Reset, Paragraph, Space, or
Creation Ti m e.

E Header: Determines whether Web
pages have a Header. Same options as
Meta Ta g s.

F Footer: Determines whether Web
pages have a Footer. Same options as
Meta Ta g s.

G Background Image: Click the box to
indicate that a background image is
to be used. Paste the selected back-
ground from the clipboard. The Name
indicated here will be displayed when
pictures are not downloaded.

H Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref -
erences on the current panel.

I Revert Panel: Restores panel to the
last-saved settings.

J Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

K OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.

D
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Background: Set a background color and/or a background
image. If you choose both, the color displays while the image is
downloading. In general, background images should be small
files that will download quickly; larger images take longer to
download, and should therefore be avoided.

For detailed information on importing a background image, click
the Help icon or see BeyondPress Online Reference: Web
Authoring: Layout: Background Colors and Images.

Headers, Footers, and Meta Tags: Headers and footers repeat
information—such as logos and copyright information—at the top
and bottom of a Web page. The header, footer, and Meta tag fea-
tures of BeyondPress allow you to add these elements automati-
cally, without building them into your pages each time. Meta tags
embed information in the <HEAD> tag of a Web page. The Meta
tag information is used by the server and search engines and is
not displayed in the Web page. In BeyondPress, headers, footers,
and Meta tags consist of default Master Elements or Master
Elements you create.

See BeyondPress Online Reference: Site Map: Web Authoring:
Layout: Adding Headers, Footers, and Meta Tags. See also
BeyondPress Online Reference: Site Map: Web Authoring:
Custom HTML: Using Master Elements as Headers, Footers, and
Meta Tags.
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Font Names Preferences 

You use the Font Names Preferences to control what fonts your
Web page will display by choosing primary and alternate type
faces.  The primary and alternate type faces you specify in the
CSS Font Info column apply to Cascading Style Sheet informa-
tion and to the Font Face tag. If you use the font in the left col-
umn in your document, the font info in the right column will be
specified in your Web page.

By default, Font Names Preferences will list all fonts installed on
your system. To show only the fonts used the Web Page you have
open, click Show Only Fonts in Document.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Font Names Pre fe re n c e s .

A Font Names Preferences Icon

B Font: Indicates fonts available to the
system, or in the document if the
“Show Only...” box is checked. Fonts
in this column, if not available to the
browser, will be replaced by the font
indicated in the second column.

C CSS Font Info: Fonts in this column
will be replace fonts listed in the Font
column, if that font is not available to
the browser.

D Help: Opens Online Help in the cur-
rently selected Web Browser.

E Show Only Fonts In Document:
Unclick to show all fonts available to
the system. Click to show only the
fonts used in the document.

F Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref -
erences on the current panel.

G Revert Panel: Restores panel to the
last-saved settings.

H Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

I OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.

E
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Media Preferences 

The Media Pre fe rences allow you to set the file type, s u ffi x , a n d
ex p o rt method for your multimedia files. By cl i cking New or Edit,
the Fo reign Object Identifier dialog box opens, letting yo u
e s t ablish data for new types of media files. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Media Pre fe re n c e s .

A Media Preferences Icon

B File Type: Lists the type of multimedia
element BeyondPress can export

C Suffix: Indicates suffix to be added to
the media file (such as .gif, .mid, .pdf,
.mov, etc.)

D Export As: Indicates what type of file
the indicated file type will be export-
ed as.

E Help: Opens Online Help in the cur-
rently selected Web Browser.

F Media Editing Buttons: Add, change,
or delete, File Types, Suffixes, and
Export type.

G Factory: Allows you to import the
preference settings that ship with
BeyondPress. Factory preferences
replace the existing preferences on
the current panel.

J Revert Panel: Restores panel to the
last-saved settings.

K Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

L OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.

E
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Site Preferences 

Setting Site Preferences prepares you for exporting and linking
Web pages by identifying where your images, media files, and
TrueDoc font PFRs are located on your hard drive or server. You
can also set folder/URL associations for sites that you frequently
link to your pages.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Site Pre fe re n c e s .

A Site Preferences Icon

B Help: Opens Online Help in the cur-
rently selected Web Browser.

C Site URL: The URLof your actual
Web site (http://yoursite.com).

D Site Folder: The local folder contain-
ing your Web site files until they are
uploaded to your Web server.

E Shared Elements: Allows you to
locate folders containing the Images,
Media and TrueDoc fonts to be used
for this Web site.

F Other Sites: Lists other local folders
you’ve associated with a specific URL
within BeyondPress.

G Other Sites Edit Buttons: Use to cre-
ate and edit folder/URLassociations
within BeyondPress. For example,
you could associate the Downloads
folder on your hard drive with the
URL: ftp://ftp.mysite.com
<ftp://ftp.mysite.com>. When you cre-
ate links to the Downloads folder with
BeyondPress, the correct URLwill be
generated in the exported HTMLdoc-
uments.

H Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref-
erences on the current panel.

I Revert Panel: Restores panel to the
last-saved settings.

J Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

K OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.
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Mapping Preferences 

Use the Mapping Preferences to have BeyondPress automatically
apply a specific HTML tag based on the QuarkXPress Style
Sheets  applied to text in the document. Style Sheets are mapped
to BeyondPress Master Styles. You can create new Master Styles
to use for mapping purposes. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : M apping Pre fe re n c e s .

A Mapping Preferences Icon

B Style Sheet: Lists all the styles in the
QuarkXPress document. Create Style
Sheets using the QuarkXPress Edit
StyleSheets dialog.

C Map To: Provides a list of all Master
HTMLtags currently stored in
BeyondPress. Pick the tag that you
want mapped to the style listed in the
corresponding Style Sheet column.
To add to the HTMLchoices, edit the
Master Styles list in the Styles
Preferences panel.

D Help: Opens Online Help in the cur-
rently selected Web Browser.

E Master Styles List: Shows the default
Master Styles. Master Styles you cre -
ate in the Styles Preferences panel
will are added to this list.

F Append: Allows you to add style
sheet mapping and Master Styles to
the current panel. Appended items
are added to existing items in the list.

J Revert Panel: Restores panel to the
last-saved settings.

K Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

L OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.

D
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Font Size Preferences 

Use the Font Size Preferences when in Conversion mode to map
the various font sizes in your QuarkXPress document to HTML
equivalents or to BeyondPress Master Styles.

Note: Font Size preferences do not apply in Authoring mode.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Font Size Pre fe re n c e s .

A Font Size Preferences Icon

B Document Point Size: Indicates point
size of text in original QuarKXPress
document to be mapped.

C Map to Size: Indicate the HTMLtag
that will be applied depending on size
of tex in the document. To add to the
HTMLchoices, edit the Master Styles
list in the Styles Preferences panel.

D Help: Opens Online Help in the cur-
rently selected Web Browser.

E Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref -
erences on the current panel.

F Revert Panel: Restores panel to the
last-saved settings.

G Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

H OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.

I Master Styles List: Shows the default
Master Styles. Master Styles you cre -
ate in the Styles Preferences panel
will are added to this list.
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Styles Preferences 

Use the Styles Preferences to create Master Styles for applying
HTML tags and attributes to Web pages. BeyondPress includes a
default list of HTML Master Styles, and you can add as many of
your own Master Styles to this list as you want. 

Note: This feature is for experienced HTML authors—Master
Styles you create must conform to HTML specifications.

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Styles Pre fe re n c e s .

A Styles Preferences Icon

B Master Styles: Factory included styles
are: Bold, Citation, Emphasis, Font
Size (1 through 7), Headline (1
through 6), Italic, Quote, Strong, and
Typewriter.

C Help: Opens Online Help in the cur-
rently selected Web Browser.

D MasterStyles Editing Button: Allows
you to create, modify, duplicate, or
delete Master Styles. To add your
own Master Styles, click the New but-
ton, enter a name for the Master
Style, then type in the HTMLtags you
wish the Master Style to represent.

E Append: Allows you to add style
sheet mapping and Master Styles to
the current panel from another docu -
ment. Appended items are added to
existing items in the list.

J Revert Panel: Restores panel to the
last-saved settings.

K Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

L OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.
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Image Preferences

Use the Image Preferences to set default preferences for all
images, including image Scale, Alignment, Format, JPEG Quality,
Scale, Spacing, Antialiasing, and more.Values specified here can
be changed for individual images using settings on the Image
Settings palette of the Attributes Inspector.

See BeyondPress Online Reference: Site Map: Features:
Preferences: Image Preferences.

A Image Preferences Icon

B Default Values: Set default values for
images. Options are: Scale Basis (Box
Scale or Unscaled), Alignment (To p ,
Middle, Bottom, Left, Center, Right),
Format (GIF or JPEG), JPEG Q u a l i t y
( Very Low, Low, Normal, High, Ve r y
High), GIF Palette (Apple System 256,
Adaptive, Load from GIF), Interlace
GIFs (specify interlacing)

C Initial Values: Set initial Scale, Horizon-
tal Space, Vertical Space, and Border.

D Help: Access Online Help.

E Image Maps: Client Side or Export
(specify NCSAor CERN)

F Antialias: Set Antialiasing Off, Low,
Medium, or High.

G Shrink Solid Images: Shrinks solid-
colored boxes to 1 pixel and uses
Height/Weight tags to stretch the
image to the final size. Results in
faster loading pages with smaller-
sized graphics.

H Reimport High Res Images: Forces
QuarkXPress to reimport images
imported using low-res QuarkXPress
preferences. Results in better looking
display of images in QuarkXPress.

Output Width/Height Tags: Enables
BeyondPress to generate correct size
tags for images on exported Web
pages.

I Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref-
erences on the current panel.

J Revert Panel: Restores panel to the
last-saved settings.

K Cancel: Closes the Preferences dia-
log box without making changes to
any of the panels.

L OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.
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Table Preferences 

Use the Table Preferences to set default table settings to be used
when converting tab delimited text and anchored image elements
into an HTML table during export.  

In Conversion mode, values specified here can be changed for
individual tables by selecting “Modify” from the pop-up menu. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : Table Pre fe re n c e s .

A Table Preferences Icon

B Default Values: Set default values for
tables. Options are: Border Width,
Cell Padding, Cell Spacing, Header
Rows, and Header Columns.

C Table Width: Specify Automatic,
Pixels, or Percent.

D Help: Opens Online Help in the cur-
rently selected Web Browser.

E Table Color: Select a default color for
tables. Click the color box to access
the system color picker and select a
color. Click the box to apply the
selection to tables on newly exported
pages.

F Table Alignment: Set Horizontal align-
ment Top, Middle, Bottom, Left,
Center or Right.

G Vertical Alignment: Set Vertical align-
ment Top, Middle, Bottom, Left,
Center or Right.

H Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref -
erences on the current panel.

I Revert Panel: Restores panel to the
last-saved settings.

J Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

K OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.
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List Preferences 

Use the List Preferences to set default values for text exported as
HTML tables during Conversion mode.

In Conversion mode, values specified here can be changed for
individual lists by selecting “Modify” from the pop-up menu. 

See Beyo n d P ress Online R e fe re n c e : Site Map : Fe at u re s :
P re fe re n c e s : List Pre fe re n c e s .

A List Preferences Icon

B Help: Opens Online Help in the cur-
rently selected Web Browser.

C List Type: Specify Ordered,
Unordered, Definition Term, Definition
Body, Menu, Directory.

D Level: Specify Level 1, 2 or 3.

E Dingbat: Specify List Dingbat as
Standard, Numeral, Uppercase
Roman Numeral, Lowercase Roman
Numeral, Uppercase Alpha, or
Lowercase Alpha.

F Strip Leading Characters: Strips lead-
ing numbers and bullets from lists in
source text so that HTMLbullets or
numbers can be applied on export.

G Import: Allows you to import settings
from another document. Imported
preferences replace the existing pref-
erences on the current panel.

H Revert Panel: Restores panel to the
last-saved settings.

I Cancel: Closes the Preferences dialog
box without making changes to any of
the panels.

J OK: Applies indicated changes on all
Preference panels and closes the
Preferences dialog box.

C

D

E

F

G H

C D E

I J

List Preferences

A B



Drag and Drop  (Macintosh Only)

BeyondPress adds Drag and Drop capability to QuarkXPress
allowing  you to drag text, image, and multimedia files to and
from Web pages.

Use Drag and Drop to:
• Drag files from the Finder into Web pages.
• Drag any element from the Document Content palette

(Conversion Mode) and place it into any application that sup-
ports Macintosh Drag and Drop. In the process, BeyondPress
“exports” the file to HTML or the designated image format.

• Drag images and multimedia files from the Elements palette to
a Web page.

• Drag HTML items from the Elements palette onto a page.
When you drag a text element from the Document Content
palette to the Desktop or Finder, BeyondPress writes a text file
containing the HTML source code of that element.

Drag text

For those using Web page templates created in another Web
authoring or HTML editing program, Drag and Drop lets you for-
mat text in QuarkXPress, then bring the HTML source directly
into another program.

Drag images

You can also use BeyondPress' image-editing capabilities, for
instance converting a TIFF image to a progressive JPEG or adding
transparency to a GIF image, then drag the image into another
HTML editing program.

Apple Events Support (Macintosh only)

BeyondPress is fully scriptable and recordable, lets you add a
Scripts menu to QuarkXPress, and includes a variety of sample
scripts.

Recording scripts

You can record BeyondPress actions with the AppleScript Script
Editor. Click Record in the Script Editor then perform operations
in BeyondPress. The recorded code shows you the terminology
for BeyondPress events. 
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Adding a Scripts menu in QuarkXPress

To add a Scripts menu to QuarkXPress, check Use Scripts Menu
in the Application panel of BeyondPress Preferences. Create a
folder called “Scripts” and place it in your QuarkXPress folder
before you launch QuarkXPress. Any script you place in that fold-
er will be listed in the Scripts menu. 

Using BeyondPress sample scripts

BeyondPress includes a sample script, “Auto Link URLs,” and a
sample applet, “Convert Everything.” These samples are immedi-
ately useful and provide examples of how scripts may be used to
automate tasks. 

Auto Link URLs

When you put the Scripts folder in your QuarkXPress folder, Auto
Link URLs appears in the QuarkXPress Scripts menu. Choose
Auto Link URLs to create links for all Web, ftp, and email
addresses in the text of your document.

Convert Everything

“Convert Everything” is in the Applets folder in the BeyondPress
folder on your hard drive. It will convert any file that can be
imported into BeyondPress — picture files, text files, word
processor files, and QuarkXPress documents. Drop any collection
of these files onto the Convert Everything icon to convert them.
Convert Everything will use your BeyondPress Preferences set-
tings when converting files.

For More Information

See the Scripting information on the BeyondPress page of the
Extensis Web site (http://www.extensis.com/beyondpress/) for
more information.
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Tutorial 1: Creating A Web Page

The following tutorial will show you how to get started using
QuarkXPress and BeyondPress to create a Web page.

N o t e : In this tutorial you will cre ate a Web page from scrat ch ,
but you can fo l l ow the same steps to conve rt an existing docu-
ment for the Web. Fo l l ow steps 1 and 2 (to open the Beyo n d P re s s
Document Content palette and select a brow s e r ) , then skip to
s t ep 6 (page 59).

This tutorial assumes that the BeyondPress XTension has been
installed in the Quark XTension folder, and that you are familiar
with the basic operations of QuarkXPress. 

1. Launch QuarkXPress without a document.

Open QuarkXPress. If you have not already done so, enter
the registration number (from the back of the User Guide) for
BeyondPress, or click “Demo” to operate with BeyondPress
in fully-functioning time-limited demonstration mode.

If the Document Content palette is not visible, select it from
the menu (Extensis > BeyondPress > Show Document
Content) or use the keyboard shortcut shown in the sidebar at
the left. You can access on-line help at any time by clicking
the light bulb icon on the palette.

If the Shared Elements palette is open, close it for now.

2. Specify a browser:

BeyondPress requires that you specify which Web browser to
use when viewing your Web pages. If you do not specify a
browser, you will be asked to do so the first time you attempt
to perform any browser-related task. You can change
browsers at any time by selecting a new browser application
in Preferences.

Tip

To show or hide the Document
Content Palette, press
Command+Option+C (Macintosh)
or Control+Alt+C (Windows).

QuarkXPress version 3.32 Users:
All BeyondPress palettes are avail -
able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.

BeyondPress Tutorials

Tip

For the most complete understand-
ing, we encourage you to actually
perform the exercises in each
Tutorial. However, you can learn a
lot about what BeyondPress can
do and how to do it it just by read-
ing through the steps and examin-
ing the examples provided. 
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Important! BeyondPress exports, by default, using DHTML
standards. DHTML is supported by Netscape and Internet
Explorer versions 4.0 and above. If you are using an earlier
version browser, or one that does not support DHTML, you
must turn this feature off. If you do not, your results may be
unpredictable.

• To turn off DHTML: Select Extensis > BeyondPress >
Preferences. Click the “Export” icon, then deselect
(unclick) DHTML. Click “OK.”

• To specify a browser: Click the Preferences icon on the
Authoring tab of the Document Content palette, or
select Extensis > BeyondPress > Preferences. Click

the Application icon. Click the HTML Browser button and
locate the browser of your choice, then click “Open.”

• Set other Application options: The rest of the options on
the Application Preferences panel are not relevant to this
discussion, but you should verify that they are set as fol-
lows: Apple Events options Off (unchecked); List Document
options On (checked); Show Hidden Text Off. (For more
information on Application Preferences see page 38).

3. Create a new document and set the Web page size.

When you create a QuarkXPress document for the Web, you
aren’t constrained by the same page size as with printed
documentation. The page can be any length, since a Web
browser allows you to scroll if the page text or images extend
beyond the viewable area. QuarkXPress sets an upper limit of
48 inches in height, and the standard browser window height
is 5 inches, so we suggest a page height somewhere between
the two. 

Tip

To show or hide BeyondPress
Preferences, press Command+
Control+Y (Macintosh) or
Control+ALT+Y (Windows).

QuarkXPress version 3.32 Users:
BeyondPress Preferences are avail-
able from the Edit menu.
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• Set Page Height: BeyondPress determines output page size
based on the dimensions of the text and picture boxes,
regardless of how much space is occupied by the text or
image inside the box. Any white space extending beyond
the last box on a page is ignored when the page is exported.
Since BeyondPress includes blank space inside the box but
not outside of it, you should be sure to size your box within
an inch or two of the text or image at the bottom of the box.
If you do not, your page will include uneccessary white
space at the bottom.

Note: If the text and images on a page fall within the 5-inch
s t a n d a rd display, the browser window is displayed without a
s c roll bar.

• Set Page Width: The standard browser window width is 7
inches wide. While you can create a wider pages, keeping
the page width to 7 inches will allow users with smaller
monitors to view the page without scrolling.

• Set Page Margins to Zero: When designing Web pages you
can use the full width of the page, extending your text
and/or picture boxes right up to the edge, so there’s no need
for page margins.

• Turn off Automatic Text box: Since BeyondPress creates
page length based on text box length, it’s best to create text
and adjust text boxes as you go.

• Turn off Facing Pages: All Web pages are single scrolling
pages, so this option should be unchecked.

We set our page size to 7-inches wide by 9-inches deep, no
margins, single column, automatic text box off, and facing
pages off.



4. Set the document to display in points.

Since Web pages are viewed on a monitor, the standard Web
measurement is pixels. Screen resolution on most monitors is
72 dpi, so before you begin designing your pages for the
Web, change the Horizontal and Vertical units to Points, and
set Points/Inch to 72.

• Set Measurements to Points: Select Edit > Preferences >
General [or press Command+Y (Macintosh) or Control+Y
(Windows)], then set the Horizontal and Vertical Measure to
Points, and the Points/Inch to 72.

• Save and name your document: Now that you’ve set all
the page parameters you’ll want to save and name your doc-
ument. We named our document “Home Page.”

Congratulations—you’re now ready to begin laying out your
page! 
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5. Create some simple elements, like a text box and a picture
box. Enter some text in the box, and import a graphic into
the picture box. Do not overlap boxes.

For this first tutorial we’ll be keeping the ele-
ments simple, and creating just one page.

First, create a text box and enter some text.
Format the text, change colors, whatever. Next,
create a picture box and import an image (if you
need an image, you’ll find some in the folder:
Extensis BeyondPress: BeyondPress Tutorial:
Coastal Web Site: Images).

Note: You may be aware that images displayed
on the World Wide Web must be in GIF or JPEG
format. With BeyondPress you can use any
image format supported by QuarkXPress—all
images are converted to GIF or JPEG format
(as specified in the Preferences) when the docu-
ment is exported to HTML.

Due to constraints in the HTML language, over-
lapped boxes cannot be output in an HTML doc-
ument. This may sound confining, but we will
show you how to manage complex boxes and
other elements later on. For now, just be careful
not to overlap boxes.
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Tip

If your images are already in GIF
or JPEG format, you can specify
that BeyondPress bypass image
conversion on export: In the Attri-
butes Inspector for the selected
image, click the “Copy Original”
checkbox. This forces Beyond-
Press to put a duplicate of your
image in the Images folder.
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6. Preview your page.

Now that you’ve created a page in QuarkXPress, let’s see
how your page will look on the Web.

• To ge n e rate a Prev i ew, cl i ck the Prev i ew (eyeg l a s s )
bu t t o n : B eyo n d P ress will begin conve rting the tex t
and images to HTML and rep o rt its progress in the

E x p o rt Progress window. 

When the conversion is complete, the selected Web browser
will be launched, and the exported page will be displayed.

You now have a viewable Web page—and you haven’t done
any HTML coding!
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7. Change the Background color.

Notice that the page background is white. BeyondPress
allows you to change the displayed background color, and
you can even specify an image as a backdrop.

• To select a background color: Open the BeyondPress
Preferences [Command+Control+Y (Macintosh) or
Control+Alt+Y (Windows)], then click the Web Page icon.
Click “Background Color:” Use the system color picker to
select a color. For now, leave the other options unchanged.

Click “OK” to close the Preferences dialog box.

If you prefer to leave the background white (as we did),
simply click Cancel to close the dialog box without making
changes.

8. Make any additional changes before exporting.

After previewing your page and changing the background
color, make any desired changes. You can play around with
text formatting, image size and placement, etc. Use the

Preview button as often as you like to see your results
in the browser.

After you’ve gotten the page just the way you want it, you
are ready to Export it. 

QuarkXPress version 3.32 Users:
All BeyondPress palettes are avail-
able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.
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9. Export your page.

If it is not already visible, open the Document
Control palette [Command+Option+C (Macintosh)
or Control+Alt+C (Windows)], then click the Export
button.

• Name and save your page: When you click the Export but-
ton, you will be given an opportunity to name the exported
page. The suffix “.html” is added to the file name. This
extension indicates that the file is in HTML format. For
now, just use the default naming “1.html” and save the page
to the desktop or to an empty folder on your hard drive.

Note: You will automatically be given
the opportunity to name your export
document only the first time you export
the page. For convenience, future
exports of that page will use that name.
You can, however, easily specify a new
export name if you wish—see page 77
for details.
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Tip

You can export multiple pages at
once in Authoring mode: On the
Document Content palette list,
select all the pages you want to
export, then drag and drop the
selection over the Export icon. If a
page has not been exported previ-
ously, you will be presented with a
dialog box allowing you to enter an
export filename for the page. 

Tip

You can can open your new Web
page right from the Export
Progress window by clicking the
“Open in Browser” button. 

You can also have BeyondPress
automatically open your browser
and display each page as it is
exported by clicking the “Automati-
cally” checkbox beside the “Open
in Browser” button. 

10. Examine the Export Progress window and the files that
were created when your document was exported.

Congratulations—you’ve just created your first Web page
using the powerful combination of QuarkXPress and
BeyondPress! But before you go on, we want to show you
some of the tools BeyondPress has provided for you, and
explain a little about the output files that were created when
the document was converted.

• Examine Export Progress: Return to your document in
QuarkXPress and notice the Export Progress window. This

window is simi-
lar to the one
produced when
you Previewed
your document,
with some addi-
tional items.

The Export
Progress window

shows document statistics such as: estimated Download
Times and File Sizes; any noted Problems in converting the
elements to HTML; the Source document and Web page
document names. This window also gives you an opportuni-
ty to determine whether or not the browser will be launched
automatically when pages are exported.

• Examine the files that were created: Look on your desk-
top, or open the folder where you saved the Exported docu-
ment. Notice that, by default, BeyondPress puts all HTML
items in one folder and the associated graphic elements in a
subfolder named “Images.”

As you can see, when your documents are converted to
HTML a number of elements may be created. As you create

more and more pages for your
Web site, you’ll want to devel-
op a strategy for managing
these files. We’ll show you a
sample organizing strategy in
“Tutorial 2: Building a Web
Site” (page 63).
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Tutorial 2: Building A Web Site

Now that you’ve seen how to create a simple web page in
QuarkXPress and export it as an HTML document using
BeyondPress, you’re ready to build an entire Web site.

Note: This tutorial demonstrates using BeyondPress Authoring
mode to create Web pages for a Web site from scratch. However,
you could use the information presented in this Tutorial to create
your Web site using existing documents, modifying them in
QuarkXPress as discussed here. For info rm ation on conve rt i n g
existing documents to Web pages using the list-oriented Conve rs i o n
mode instead, re fer to the tutorial “Using Conversion Mode”
starting on page 79.

In the following example you’ll use elements (text and images)
already created and available in the BeyondPress Tutorial folder.
You’ll lay the elements out in QuarkXPress, then you’ll export the
documents to convert your document pages to Web site pages.
You’ll see how the exported Web files are organized, and you’ll
create active link buttons to navigate the pages of your web site.

Tip

For the most complete understand-
ing, we encourage you to actually
perform the exercises in this
Tutorial. However, you can learn a
lot about what BeyondPress can
do and how to do it it just by read-
ing through the steps and examin-
ing the examples provided. 
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1. Locate the BeyondPress Tutorial folder.

To begin, locate the BeyondPress Tutorial folder located in
the Extensis BeyondPress™ folder on your hard drive, and
place it somewhere where you can access it easily, such as on
your desktop. 

2. Set Site preferences.

Before you create pages for publication on the World Wide
Web you must create folders to contain the pages, images,
fonts, and multimedia files that will make up your Web site.
The BeyondPress Tutorials folder contains a sample Web site
folder, “Coastal Web Site,” complete with the proper folders
and sample files. You will be using those files and folders for
these tutorials, and you can use the folder layout as an exam-
ple for setting up your own Web site folders. 

You use the Site Preferences to tell BeyondPress the location
of all the files and folders that make up your Web site. This
allows you to work on a local copy of your Web site (without
having to upload files to a Server), then easily move the fold-
ers to your Web Server when page design is complete .

• Examine the contents of the Coastal Web Site folder in
the BeyondPress Tutorial folder. Notice the types of fold-
ers and their contents. The Coastal Web Site folder contains
subfolders including three named “Images,” “Media,” and
“TrueDoc Fonts.” These folders contain shared items and
are examples of how a typical Web site might be set up.

After you finish this tutorial, you can make a copy of the
sample Web site (delete the content files first!) to use as a
starting point for your own Web site.

Keep the Coastal Web Site folder open and within easy
reach—we’ll be using it throughout this tutorial.

• Display the Site panel in the BeyondPress Preferences
dialog: Open QuarkXPress with no document open, then

open the BeyondPress Preferences [Command+
Control+Y (Macitntosh) or Control+Alt+Y
Windows)]. Locate the “Site” button or tab, then

click it to open the Site Preferences panel .
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• Designate the Web Site folder for your site:

Windows: Click the Site Folder button “<None>” and
locate the \Programs\Extensis BeyondPress\BeyondPress
Tutorial\Coastal Web Site folder. Click “Select.”

Macintosh: You can click the Site Folder “<None>” button
and search the folder hierarchy (see “Windows:” above), or
you can drag and drop folders into the Preferences pane. To
use drag and drop, locate the Extensis BeyondPress:
BeyondPress Tutorial folder and position it on the desktop
so that you can see this folder with Quark X P re s s open. If
necessary, move the Preferences dialog box and the Tutorial
folder so that they don’t overlap. 

Select the Coastal Web Site folder, then drag and drop it
over the Site Folder button in the Site Preferences panel.

This designates the Coastal Web Site folder as your Web site.



• Designate the Shared Elements folders for your site:

Wi n d ow s : Using the buttons in the Site Pre fe rences pane (the
same way you added the Coastal Web Site fo l d e r ) , l o c ate and
a dd the Image s , M e d i a , and TrueDoc Fonts fo l d e rs .

Macintosh: Drag the Shared Images folders from the
Coastal Web Site to the appropriate locations in the Site
Preferences panel: Images to Images, Media to Media, and
TrueDoc Fonts to TrueDoc Fonts. 

For now, ignore the other options on the Site Preferences
panel. 

Note: BeyondPress puts unshared elements into the location
specified in Export Preferences. See page 39.

When you’re finished, your Site panel should look some-
thing like this:

This process tells BeyondPress where to put the files it cre-
ates when converting your document to HTML. But even
more importantly, you’ve enabled BeyondPress to create rela-
tive links to all your Web page documents. This will allow
you to thoroughly test your links between Web pages before
you upload them to an online Web server. When it’s time to
publish your Web site, you can move the entire folder to the
host server with all the links intact. 

Click “OK” to save the settings and close the Preferences
dialog.
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3. Set Web Server Preferences.

When BeyondPress converts your document to HTML during
the Export process, it creates files specific to the platform of
your Web Server (Mac OS, DOS/Windows, Win95/XT, or
UNIX). You specify server platform in the Preferences dia-
log.

• Specify Web Server Preferences: From the Preferences
di a l og [Command+Control+Y (Macintosh) or Contro l + A l t + Y

( Wi n d ow s ) ] , select the Export icon. From the Destina-
tion Plat fo rm pop-up, select the ap p ro p ri ate plat fo rm
for the server wh e re you will be publishing your Web

site (Mac OS, DOS/Windows, Win95/XT, or UNIX). If
yo u ’re not sure about the destination plat fo rm , ask your Web

site A d m i n i s t ator or Internet Service Provider (ISP).

For the purposes of these tutorials, you can select the
platform that you will be practicing on—just be sure to set
these preferences correctly for your Web Server before you
export documents for publication on the Server.

Note: If you have not already done so, you will need to
specify the browser that BeyondPress will use to preview
your pages: If the BeyondPreferences dialog is not open,
open it now [Command+Control+Y (Macintosh) or Con-

trol+Alt+Y (Windows)]. Click the Application icon.
Click the HTML Browser button, locate the browser
of your choice, then click “Open.”

QuarkXPress version 3.32 Users:
All BeyondPress palettes are avail-
able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.
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4. Create a Web page template, complete with shared
images.

To streamline formatting and keep your Web pages consis-
tent, you can start off your web site design with a
QuarkXPress template. If you’re not familiar with templates,
a template is a preformatted document that, when opened,
creates a new, unsaved document window. Using templates
for Web pages is particularly useful because you can add
images and create links from them to construct some basic
navigation for your Web site.

In this tutorial we’ll be constructing a template to include the
navigation button bar at the top of each page in our Coastal
Web Site.

• Set page size: Open a new document in QuarkXPress and
set the page parameters as follows (see page xx for addition-
al information): Width=7”, Height=9”, no margins, no fac-
ing pages, single column. Click “OK.”

• Set Measurements to Points: As you did in the first tutori-
al, open the QuarkXPress General Preferences (Com-
mand+Y) dialog box and set the Horizontal and Vertical dis-
play measurements to Points, and Points/Inch to 72.

• Add images to the Master Page: Open the Master Page for
your document (Page > Display > A-Master A), then
open the Shared Elements palette [Command+
Control+S (Macintosh) or Control+Shift+S
(Windows)] and click the Image tab. Resize the
Shared Elements palette as necessary to see all the
images. Select the Item tool .

Drag all of the items that begin with the word “tool”
and drop them onto the Master page of your docu-
ment.  Or create five picture boxes and bring in the
images using the QuarkXPress “Get Picture” com-
mand.

If you drag and drop the images they will be placed
in the document stacked on top of each other. To sep-
arate them, simply drag each image away from the
group.
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• Place the images along the top of the page: Arrange the
images loosely near the top of the page in the following
order: Home, News, Veria Mask, Xeno Fin, and Zetra Fin.
Make sure that at least one image is flush against the top
margin (has a Y coordinate, or Origin Down, of 0 points).

Select all the items [Command+A (Macintosh) or
Control+A (Windows)], then open the QuarkXPress
Space/Align Items dialog box (Item > Space/Align). Set the
Horizontal alignment to Space: 0, and set the Vertical align-
ment to Space: 0, Between: Top Edges. Click “OK” to align
the items and close the dialog box.

The navigation bar buttons should now be aligned perfectly
along the top of the Master Page. Close the Shared Elements
palette.



70

5. Create appropriate links to other Web pages.

To complete the Web site navigation bar, we’ll need to link
the images to their corresponding Web pages. The links will
“remember” their destination as long as the Web pages
remain in the locations you specified in Site Preferences
(shown in step 2, page 64).

• Open the Attributes Inspector: Select Extensis >
BeyondPress > Show Attributes Inspector. A blank Inspector
window is displayed.

Note: You can also open the Attributes Inspector from
the Document Content palette by clicking the Micro-

scope button.

• Display Image Settings for the Home button: Select the
“Home” button image in the document. Notice that the

Attributes Inspector now reads “Image Settings” and
displays information about the selected image; as dif-
ferent items are selected (including text boxes) this
window changes to reflect the settings for that item.
Click the triangle at the bottom of the Image Settings
window to expand the window to show Image Map
and Transparency.

• Set the “Home” button link: Select the Rectangle
Link tool from the Image Map area of the
Image Settings window, then draw a rectangle

around the word “Home” in the image. When you
release the mouse you will be presented with a dia-
log box so that you can locate the page to be linked.
Click “Locate
File. . .” Locate the
Coastal Web Site
folder and select
the “index.html”
file.

Tip

You can open the Attributes
Inspector by pressing Command+
Control+M (Macintosh) or Con-
trol+Shift+M (Windows).

QuarkXPress version 3.32 Users:
All BeyondPress palettes are avail-
able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.
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Note: If you have multiple copies of the Coastal Web Site
folder on your system make sure you link the “index.html”
image from the same Coastal Web Site folder that you set in
the Site Preferences (page xx).

Click “Open” to link the “index.html” page of our Web site
to the “Home” button.

• Set links for the remainder of the Web site navigation
buttons: Using the same process that you followed to set
the link for the “Home” button, link the remaining buttons. 

Link the “News” image to the “news.html” page located in
the Newsletters folder of the Coastal Web Site.

Link the remaining images to their respective pages located
in the Products folder of the Coastal Web Site.

When you have finished linking all the buttons, close the
Image Settings window.

• Save your completed Template: Return to the document
page (Page > Display > Document), then use the
QuarkXPress “Save as. . .” command to save the document as
a Template. [File > Save As, or Command+Option+S
(Macintosh) or Control+Alt+S (Windows)]. Click
“Template” and name the document “Coastal Web Page
Template.” We suggest you save it in the “Sources” folder in
the BeyondPress Tutorial folder.

Changes to BeyondPress Preferences, dialog boxes, and pal-
ettes are kept with the source document, so you should save
your document periodically as you complete these exercises.

6. Optional: Export the document and test the links.

Before you use your new Template to create additional pages
for your Web site, you may want to verify that the links are
set properly by exporting the page and testing the links. 

• To Export your page: If it is not already visible, open the
Document Control palette [Command+Option+C

(Macintosh) or Control+Alt+C (Windows)], then
click the Export button. For more information on

exporting a document, refer to the exporting section of
“Tutorial 1—Creating a Web Page,” page 62.

• Check the links: When the document opens in your select-
ed browser, click each of the navigation buttons and verify
that it links to the correct page. If you need to specify a
browser, refer to the tutorial “Creating a Web Page,” on
page 54.

Tip

To preview or test links you must
export both the file you are linking
and the file you are linking to.
Testing links in Preview mode will
not work unless linking directly to
an external Web site
(http://www.yoursite.com). 
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7. Add a page to the Web site.

In this section you will use QuarkXPress to create the layout
for a Web page using the Template you created earlier and
some pre-existing text and images. You’ll be working in
BeyondPress Authoring Mode.

With BeyondPress you have two ways to add pre-existing
text and pictures to your document. You can:

• Use the traditional QuarkXPress method of drawing boxes
and importing the text or picture.

— or —

• Macintosh: Drag and Drop your text and images into your
document and allow BeyondPress to automatically create
the necessary boxes. 

Note: As always with QuarkXPress, you must have the neces-
sary text and picture import filters running before you can
import stylized text using any method. This exercise requires
the MS Word filter. If necessary, refer to your QuarkXPress
User Guide for information on import filters.



• Create a new page: Select File > Open [or Command+O
(Macintosh) or Control+O (Wi n d ow s ) ] , then select and open
the Coastal Web Site Te m p l ate that you cre ated earl i e r. Name
the new document “ Z e t ra ” ( File > S ave as. . .) and save it to the
“ S o u rce Fi l e s ” folder in the Beyo n d P ress Tu t o rial fo l d e r.
B eyo n d P ress settings are kept with the document, so save
your document peri o d i c a l ly throughout this exe rc i s e. 

• Set up Authoring Mode: Make sure the Document Content
palette is open [Command+Option+C (Macintosh) or Contro l +
Alt+C (Windows)] and that the Authoring tab is selected.

• Get pictures and Text:

Macintosh: You can drag and drop text and pictures: First,
locate and open the “Text and Pictures” folder inside the
“Source Files” folder in the BeyondPress Tutorial folder.
Next, resize and reposition your document window and the
Text and Pictures folder so that both are show i n g. If neces-
s a ry, ch a n ge your document view to Fit in Wi n d ow
( C o m m a n d + 0 ) . Then select all four items in the folder, and
drag and drop them into the document window.

Windows: Draw two picture boxes and two text
boxes, then use “Get Picture” and “Get Text” to
bring in the pictures and text items from the
Text and Pictures folder in the BeyondPress
Tutorial Folder.
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• Arrange the items on the page: If you dragged the items
as a group, they will be placed in the document stacked on
top of one another. Drag the items to appropriate locations
on the page, and size the text boxes so that all the text is
visible. (Make the “Zetra Fin.wrd” text box about 230x280
pixels, and the “Fin Specs.wrd” box about 220x220 pixels.)

Arrange the text and picture boxes as you want them.

Note: If your design contains overlapping text boxes, make
sure that the DHTML/CSS Positioning option is enabled in
the BeyondPress Layout Preferences. Because standard
HTML does not support overlapping objects, if you create
overlapping boxes in Authoring mode without the DHTML
preference set, you will generate errors when you export the
document. 
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• A n chor the Fin Colors image in tex t : Select the Fin Colors
i m age with the Item tool , then Cut it from the document.
This places the image on the cl i p b o a rd. Nex t , select “ S h ow
I nv i s i bl e s ” [Command+I (Macintosh)] or [Control+I (Wi n-
d ows)] so that you can see the Tab marke rs to easily anch o r
the image in tex t .

Switch to the Content tool and click in the last line of
the text (“Colors:”) just after the Tab marker, then Paste the
image. Resize the text box if necessary to see the text and
the anchored picture. Notice that anchored picture sits on
the baseline, interfering with the text above it.

• Adjust the Ascent of the anchored picture: Click on the
Fin Colors image to select it, then click the Ascent icon on
the Measurements palette.

This will push the image down so that it aligns properly
with the text.

8. E x p o rt the page to conve rt it to an HTML document.

When you export a finished Web page document,
BeyondPress creates all the necessary files and places them
in the appropriate folders on your Web site. The Export
Progress palette, which is displayed while your Web page is
being exported (that is, converted to HTML format), provides
information about the size of the files that make up the page,
an estimate of how long the file will take to download at vari-
ous modem speeds, and alerts you to potential problems with
the items on the page, etc.

• B a ck ground color: The default back ground color for yo u r
p age is Wh i t e. You can ch a n ge the back ground color, and eve n
a dd a back ground image : C l i ck the Pre fe rences button on the
Document Content palette, cl i ck the Web Page icon, then use
the system color palette to select a Back ground color. Click
“ O K ” to close the Pre fe rences and implement the ch a n ge.

Ascent 

Tip

If a yellow warning dialog appears
during export, it means you can
have Beyond-Press locate the
offending item so that you can
remedy the situation. To locate the
item, double-click the error icon—
BeyondPress will select the
offending element and move to the
area of the document containing it.
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• Specify display page name: BeyondPress allows you to
save your exported HTML page documents with any name
that makes sense to you, such as “index,” “site map” etc.
You can specify a page document name when you export
the document (see page xx). But more importantly, you can
specify a different name to be displayed in the browser title
bar when your page is loaded. In BeyondPress, this “dis-
play” name is shown on the page list in the Document
Content palette Authoring panel. 

As you create pages in Authoring Mode, they are added to
the page list and given consecutive numbers (1, 2, etc.) To
change the display name for a page, open the Document
Content palette [Command+ Option+C (Macintosh) or
Control+Alt+C (Windows)] and select the Authoring panel.
Select the current name and type in the new name. When
your page is displayed in the browser window this name
will be used. We specified the name “About Zetra Fins” for
our display name.
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• Export the source page and change the Web page docu-
ment name: On the Authoring panel, select “Export as. . .” to

specify a new Web page document file name, then
enter the new name.

Since our source document contains only one page, we
decided to use the same name for our Web page document,
naming it “Zetra.html.” You must use the extension “.html”
on all exported pages—if you do not, the Web browser will
not recognize the file as a viewable page. Save Zetra.html to
the Products folder in the Coastal Web Site folder. Click
“Replace all” to replace the existing Zetra export files.

• Examine your newly created page: Open your newly
created page in your browser.

Click the navigation buttons in the window to link to the
other pages in the Web site. There’s even a multimedia
element on the Home page for your enjoyment!

Click back to the Zetra page to see your own creation. When
you’ve finished viewing the Web pages, return to your docu-
ment in QuarkXPress.

Tip

You can can open your new Web
page right from the Export
Progress window by clicking the
“Open in Browser” button. 

You can also have BeyondPress
automatically open your browser
and display each page as it is
exported by clicking the “Automati-
cally” checkbox beside the “Open
in Browser” button. 
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• Examine the Export Progress window: While
BeyondPress is converting your document to HTML and
exporting the various elements, a progress window is dis-
played. When the conversion is complete, this Export
Progress window gives you important information about the
export process and the files that were created.

The top line in the window shows you the page that was
exported (“About Zetra Fins”) and the name of the html file
that was created (“New Zetra.html). If you do not want to
view your Web pages automatically after export, deselect
this option by un-checking the “Automatically” checkbox.

The “Statistics” area shows you approximate download
times for the resulting page over internet connections of
varying bandwidths, and the total file size for the page doc-
ument and any images on the page.

The “Problems” area gives a report on any errors encoun-
tered during the conversion. Export problems and potential
problems are covered in detail in the online User Guide, in
the sections “Export Progress Window” and “Export Error
Messages.”

As you wo rk with Beyo n d P ress to cre ate your own Web
p age s , l a u n ch the Beyo n d P ress Online Refe rence and visit
the Site M ap for a listing of interesting topics. ( The Site
M ap is also printed in Appendix C, p ages 96-98.)

Or simply cl i ck the Help icon on any active window to go
to the ap p ro p ri ate page in the Beyo n d P ress Online
R e fe rence for that topic. 

R e fer to p ages 18 through 51 in this printed User Guide fo r
i n fo rm ation about the va rious Beyo n d P ress palettes, t o o l s ,
and pre fe rences. 

H ap py authori n g !
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Tutorial 3: Using Conversion Mode

Authoring mode (described in Tutorials 1 and 2) allows you to
create new Web pages or to convert existing documents to the
Web using a WYSIWYG approach and making changes right in
the document. However, sometimes you may want to place only
certain items from the document on the Web page, or you may
want to create Web pages that contain elements from the docu-
ment but look different, without maintaining two separate Quark-
XPress documents (one for print and one for Web). In these cases
you would use Conversion mode to create the Web page.

The Conversion mode process consists of building a list of items
that you want to appear on each Web page and in
what order, then exporting the document, allowing
BeyondPress to do the page layout. You can select
items individually, or you can add the entire
contents of a document to the Conversion List
automatically.

During conversion BeyondPress anchors pictures in
text and maps QuarkXPress font sizes to HTML
font sizes. Items are placed on the Web page in the
order in which they appear on the list.

Tip

For the most complete understand-
ing, we encourage you to actually
perform the exercises in this Tutor-
ial. However, you can learn a lot
about BeyondPress Conversion
mode just by reading through the
steps and examining the examples
provided. 



1. Create a Content List of items to be exported.

• Open and prep a re the Coastal Newsletter source fi l e.
From Quark X P re s s , select File > O p e n , then locat e
and open the Coastal Newsletter template in the
S o u rce Files folder in the Beyo n d P ress Tu t o ri a l
fo l d e r. Save the document with any name that yo u
l i ke. The settings and options you set fo r
B eyo n d P ress during this tutorial are saved along
with the Quark X P ress document, so save
p e ri o d i c a l ly during this exe rc i s e.

Select View > Show Guides (or press F7) and View > Show
Invisibles [or press Command+I (Macintosh) or Control+I
(Windows)]. Select the Item tool , then Shift-select the
following three text boxes from Page 1, in the exact order
indicated: the nameplate (“Coastal Dive Shop”), the
subhead (“Dive with us. . .”), and the main story (“Shipwreck
off Bermuda. . .”).
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• Create the Content List: Open the Document Content
palette by selecting Extensis > BeyondPress > Show
Document Content [or press Command+Option+C
(Macintosh) or Control+Alt+C (Windows)] then click the
Conversion tab to activate Conversion mode.

Click the “Add Items” button—a folder will immediately be
added to the Content List and the three items you
selected above will be added to the list. 

When the list is exported, everything in the folder (indented
under it on the list) will appear on the same Web page, and
the exported Web page will be given the same name as the
folder.
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able from the View menu. Beyond-
Press Preferences are available
from the Edit menu.
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2. Add an item from another page.

With BeyondPress Conversion mode, you can selectively
choose which items and text to include on your Web page,
and which to leave out.

• A dd the Fish picture to the Content List: On the
Content List, select (highlight) the last item on the list
( S h i p w re ck off Bermuda). This sets the insertion point fo r
wh e re additional items will be added to the Content List;
n ew items are added after the highlighted item.

S c roll down to Page 2 in the document, then with the Item
tool , select the Fish picture box .

Click the “Add Items” button—the Fish picture will be
a dded to the list after the “ D ive with Us...” a rt i cl e. 



• P rev i ew your new Web page : Thus far you’ve added two
text chains and two pictures to your Web page. Let’s see
how it looks. 

First, on the Content List, click the folder icon. This selects
the folder and tells BeyondPress that you want to export the
whole page for your preview. If you select just one item on
the list (such as the Fish picture), when you click the
Preview button BeyondPress will export just that item. 

With the Web page folder icon selected, click the Preview
button. B eyo n d P ress ex p o rts your document to a
t e m p o ra ry fi l e, then launches the specified brow s e r

and displays the Web page in progress. Use the Prev i ew
button at any time to see how any selected item on yo u r
Content List will look in your brow s e r.

When the browser opens with the Web page preview, notice
that BeyondPress has placed
the items on the page just as
they appear on the Content
List, with the Fish picture
appearing at the bottom of
the page.

Let’s relocate the Fish picture
so that the layout is more
appealing.
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3. C h a n ge the order of items displayed on the Web page by
re o rd e ring an item on the Content List.

• M ove the Fish image : As you saw in the last step, items
appear on the exported Web page in the order in which they
appear on the Content List. You can ch a n ge the order at any
time by dragging icons to a new position on the list. 

R e t u rn to the document in Quark X P ress. On the Content
L i s t , select the Fish picture icon and care f u l ly drag it
B e t ween the “ D ive with Us” and “ S h i p w re ck off
B e rmu d a . . .” t ext icons. An insertion line will be drawn to
s h ow you wh e re the items will be placed when you re l e a s e
the mouse. The folder (Untitled Web Page) should be
h i g h l i g h t e d. 

N o t e : If you release the mouse when either “ D ive with
U s ” or “ S h i p w re ck off Beru mu d a ” is highlighted, you are
telling Beyo n d P ress to anchor the item in the highlighted
t ext chain. If this hap p e n s , an “A n chor Items in Tex t ”
d i a l og will be displaye d. We will discuss anch o red items
s h o rt ly. For now, s i m p ly cl i ck “ C a n c e l ” and try aga i n .

• E n s u re that the Fish picture is displayed against the
right margin by modifying the alignment para m e t e r :
With BeyondPress, you can specify exactly how your text or
picture will appear by modifying item parameters.

On the Content List, in the right-hand column beside the
Fish picture icon, click “Modify.”

The Image Settings dialog will be displayed.

From the Alignment pop-up menu under the
Format tab, select “Right,” then click “OK.”
This will align the Fish image with the right-
hand margin.



N ow that yo u ’ve ch a n ged the placement of the Fi s h
p i c t u re, and made sure that it’s aligned ri g h t , l e t ’s see how

it looks: On the Content List, select the folder icon,
then cl i ck the Prev i ew bu t t o n .

The Fish picture is now strat egi c a l ly placed alongside the
“ S h i p w re ck off Bermu d a ” a rt i cl e.

You have just seen how to cre ate a Web page folder on the
Content List to hold items that you want to appear on the
Web page, h ow to add items to the Content List, and how
to re a rra n ge items and modify their para m e t e rs so that they
d i s p l ay just as you want them to. Next yo u ’ll see how
B eyo n d P ress handles images that have been grouped using
the Quark X P ress “ G ro u p ” c o m m a n d. 
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4. Add a grouped image to the Web page.

• A dd the grouped image to the Content List: In Quark -
X P re s s , go to Page 1 of the new s -
letter document. 

Select the Item tool , then select
the box with red text that begi n s
“Be the fi rs t . . .” This is a gro u p e d
b ox containing a text box , t wo dot-
ted lines, and a fl ag icon.

On the Content List, click the Web
page folder icon to select it. This tells BeyondPress that you
want to add the selected item to this Web page.

Note: If you do not select a Web page folder icon before
adding items to the Content List, BeyondPress will assume
that you want to create a new Web page, and it will create a
new folder for the item(s) being added.

With the “Be the first” group selected, click the “Add Items”
button—the grouped item will be added to the
Content List.

Notice that the grouped item, wh i ch is shown on the list as
“ G roup Image,” is displayed as a fo l d e r. Inside this Gro u p
I m age folder all the items included in the group are dis-
p l aye d : one picture, t wo lines, and a text box. You can, i f
you wish, rename this Group Image so that you can easily
d i ffe re n t i ate it from other group image s .



5. Anchor an image in text.

If you prev i ew the Web page at this point, you will see that
the grouped image “Be the fi rs t ” is displayed at the top of
the Web page. Since this group image ap p e a rs fi rst on the
list of items on the Content List, this is ex a c t ly as yo u
would expect. Let’s move the image to a more ap p ro p ri at e
l o c ation in the document.

• R e o rder the grouped image on the Content List: On the
Content List, select the “ G roup Image ” folder icon and
d rag it on top of the “ S h i p w re ck in Burmu d a ” t ext icon. 

When you drop the group image you will be pre s e n t e d
with the “A n chor Item in Text Chain” d i a l og. This allow s
you to specify wh e re in the selected text chain you want to
see your image displaye d. 

Note: You can anchor individual images as well as grouped
images.

• I n d i c ate wh e re in the text to anchor the image : Select
the QuarkXPress Text tool, then click in the last column of
the page just after the word “globe.”

When you’ve indicated where to anchor the image, click
“OK” on the “Anchor Item. . .” dialog. This closes the dialog
and places a red box at the location you specified as the
anchor point, indicating that the image will be embedded at
this location when the page is exported.
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On the Content List, notice that the Group Image folder is
n ow indented under the “ S h i p w re ck off Burmu d a . . .” t ex t
ch a i n , i n d i c ating that it is anch o red in that chain. 

6. Tweak image attributes to position the image properly on
the page.

If you prev i ew the Web page at this point you will see that
the embedded group image occupies a line by itself. Yo u
can make the layout mu ch more appealing by ch a n gi n g
some of the at t ri butes of the image.

• Align the image Left, and provide white space
( ru n a ro u n d ) : In the right-hand column of the Content
L i s t , n ext to the Group Image fo l d e r, select “ M o d i f y ” f ro m
the pop-up menu .



On the Fo rm at tab of the Image Settings dialog, s e l e c t
“ L e f t ” f rom the Alignment pop-up menu .

N ex t , cl i ck the Scale tab. Click the HSpace ch e ck b ox to
a c t ivate Hori zontal Spacing, and enter a value of 20 pt.
This will add a 20 pt. ru n a round around the embedd e d
i m age.

When you have finished modifying image at t ri bu t e s , cl i ck
“ O K ” to close the dialog and ap p ly the settings.
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• P rev i ew the Web page : To see how your page is coming
a l o n g, select the Untitled Web Page folder and cl i ck
the Prev i ew icon. 

Your Web page prev i ew should look something like this:

You have seen how to include group images on your page,
h ow to anchor them in tex t , and how to modify item at t ri b-
utes so that the layout is ex a c t ly as you wa n t .

N ow yo u ’ll ex p o rt the Web page so that it can be uploaded
to your Web serve r.
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4. Export the completed Web page.

Exporting a Web page in Conversion mode is nearly identical
to exporting in Authoring mode—the Export Progress win-
dow is the same, and the output files are placed in the appro-
priate folders as specified in the Site panel of the Preferences
dialog. For additional information on exporting a Web page,
refer to tutorial pages 62 and 77.

• Rename and Export the Web page fo l d e r : On the Con-
tent List, highlight the “Untitled Web Page ” folder name
and ch a n ge it to “ N ew s .”

From the Export pop-up next to the News fo l d e r, s e l e c t
“ E x p o rt .”

L o c ate and open the New s l e t t e rs folder inside the Coastal
Web Site fo l d e r. The default filename should appear as
“Untitled Web Page. h t m l .” C h a n ge the name to
“ N ew s . h t m l ” then cl i ck “ S ave.” A dialog will be displaye d
asking if you want to replace the existing fi l e. Click
“ R ep l a c e.” If you also see a dialog asking you to rep l a c e
the image s , cl i ck “ R eplace A l l .”

B eyo n d P ress will begin conve rting the document
and ex p o rting image fi l e s , and the standard Export
P rogress window will be displaye d. 
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Tip

The name of the Web page shown
on the Document Content palette
will be the title of the page dis-
played in the Title Bar of the Web
browser. Changing the name of
the output file when the page is
exported does not change the title
of the page in the browser.
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• Examine the Export Progress dialog and the exported
files. When the conve rsion has been completed, the Export
P rogress dialog will indicate the name of the file that wa s
c o nve rt e d, and the name it was conve rted to. In this case,
“Untitled Web Page ” was conve rted to the HTML docu-
ment “ N ew s . h t m l .”

If you wish to view the page in your brow s e r, cl i ck the
“Open In Brow s e r ” button. Notice that the page name fro m
the Content List “Untitled Web Page ” is displayed in the
b rowser title bar. You can ch a n ge this name befo re ex p o rt-
ing the document.

Also notice that the GIF images that we re cre ated by
B eyo n d P ress during the conve rsion we re placed in a
“ N ew s ” folder at the same level as the “ N ew s . h t m l ” Web
p age document. You can have Beyo n d P ress eliminate this
s t ep and copy your GIF and/or JPEG images dire c t ly by
selecting the image and cl i cking “ C o py Ori gi n a l ” on the
I m age Settings dialog.
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Document Content Palette Command+Option+C Control+Alt+C
Elements Palette Command+Control+S Control+Shift+S
Attributes Inspector Command+Control+M Control+Shift+M
BeyondPress Preferences Command+Control+Y Control+Alt+Y

Appendix A: Keyboard Shortcuts

Show/Hide Macintosh Windows

Select all items Command+A Control+A
Select multiple items Shift+Click or Marquee Right-click or Marquee
Select previous item Up Arrow Up Arrow
Select next item Down Arrow Down Arrow
Delete selected items Delete Delete
Open a modify dialog for selected item Command+Down Arrow Control+Down Arrow

or Command+click or Right-click
Open selected Web page or Text Chain Command+Right Arrow Control+Right Arrow
Close selected Web page or Text Chain Command+Left Arrow Control+Left Arrow
Scroll the list up Up Arrow Up Arrow
Scroll the list down Down Arrow Down Arrow
Display item’s full name in edit field Right Arrow Right Arrow
Return to document Return or Enter Return or Enter

Function Performed Macintosh Windows

Working with the Document Content Palette (Conversion Mode) Content List

Use these keyboard commands when the Document Content palette is the active window (indicated by a
border surrounding the Content List):

Accessing Palettes and Preferences

Use the following keyboard commands to Show or Hide the indicated palette or dialog box. These key
commands can be edited from the Extensis > Edit Key Commands menu (QuarkXPress v4.x only):

Anchor image in text F14 F14
Create link from image F15 F15
Apply HTML style (Master Style) to text F14 F14
Create link from text F15 F15
Segment text chain Shift+F15 Shift+F15

Function Performed Macintosh Windows

Working with Selected Pictures or Text in a Document

Use these keyboard commands to anchor images, apply BeyondPress Master Styles, segment text chains,
and create links. When applying Master S t y l e s , you can combine the Command and Shift keys (Macintosh)
or Control and Shift keys (Wi n d ows) to select ra n ges of tex t , then press F14. Type the fi rst few letters of
the style you want to ap p ly, then cl i ck OK.



BeyondPress provides mapping for many charac-
ters outside the basic ASCII character set. Char-
acters are mapped to their equivalent representa-
tion in the ISO 8859-1 (Latin-1) character set. 

QuarkXPress Special Character conversions:

Character Keyboard Command Maps To

New Paragraph Return <P>
New Column Enter <P>
New Page Shift+Enter <P>
Line Break Shift+Return <BR>
Space (all types) Option+Space, etc. space
Tab Tab $009

Expanded ASCII Character Set conversions:

Character Name Maps To

# pound sign #
! exclamation !
$ dollar $
% percent %
& ampersand &amp
( open parens (
) close parens )
* asterisk *
+ plus +
, comma ,
- minus -
. period .
/ slash /

0-9 Numbers 0 through 9 0-9
: Colon :
; Semi-colon ;
< Less than &lt
= Equal =
> Greater than &gt
? Question ?
@ At sign @
[ Open bracket [
\ Backslash \
] Close bracket ]
^ Umlaut ^
_ Underline _
` grave accent `

Character Name Maps To

a-z lowercase letters a through z a-z
{ open curly bracket {
| pipe character |
} close curly bracket }
Ä A umlaut &Auml
Å A ring &Aring
Ç C cedilla &Ccedil
É E acute &Eacute
Ñ N tilde &Ntilde
Ö O umlaut &Ouml
Ü U umlaut &Uuml
á a acute &aacute
à a grave &agrave
â a circumflex &acirc
ä a umlaut &auml
ã a tilde &atilde
å a ring &aring
ç c cedilla &ccedil
é e acute &eacute
è e grave &egrave
ê e circumflex &ecirc
ë e umlaut &euml
í i acute &iacute
ì i grave &igrave
î i circumflex &icirc
ï i umlaut &iuml
ñ n tilde &ntilde
ó o acute &oacute
ò o grave &ograve
ô o circumflex &ocirc
ö o umlaut &ouml
õ o tilde &otilde
ú u acute &uacute
ù u grave &ugrave
û u circumflex &ucirc
ü u umlaut &uuml
† cross &Yacute
° degree &#176
¢ cent &#162
£ pound &#163
§ section &#167
• bullet *
¶ pilcrow &#182
ß sz ligature &szlig
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Appendix B: Character Mapping Table



Character Name Maps To

‘ typesetter’s single open quote '
’ typesetter’s single close quote '
÷ divide &#247
◊ multiply symbol &#215
ÿ y umlaut &yuml
Ÿ Y umlaut &#159
⁄ solidus &#142
¤ currency &#164
‹ less &ETH
› greater &eth
fi fi ligature &THORN
fl fl ligature &thorn
‡ double cross &yacute
· middle dot &#183
‚ low quote &#130
„ low double quote &#132

‰ percent &#137
Â A circumflex &Acirc
Ê E circumflex &Ecirc
Á A acute &Aacute
Ë E umlaut &Euml
È E grave &Egrave
Í I acute &Iacute
Î I circumflex &Icirc
Ï I umlaut &Iuml
Ì I grave &Igrave
Ó O acute &Oacute
Ô O circumflex &Ocirc

apple &#149
Ò O grave &Ograve
Ú U acute &Uacute
Û U circumflex &Ucirc
Ù U grave &Ugrave
ı small 1 &#158
ˆ circumflex &#136
˜ tilde &#152
¯ macron &#175
˘ accent breve (breve)
˙ dot accent (dot)
˚ ring &#154
¸ cedilla &#184
˝ dbl acute accent &#180;&#180
˛ ogonek (ogonek)
ˇ inverse circumflex &#157

Character Name Maps To

® registered &reg
© copyright &copy
™ trademark &#153
´ acute accent &#180
¨ umlaut &#168
≠ not equal !=
Æ AE ligature &AElig
Ø O slash &Oslash
∞ infinity (infinity)
± plus/minus &#177
≤ less equal &#190
≥ greater equal >=
¥ yen &#165
µ micro &#181
∂ delta &#143
∑ sum (sum)
∏ PI &#189
π pi &#188
∫ integral (integral)
ª fem ordinal &#170
º masc ordinal &#186
Ω omega (omega)
æ ae ligature &#aelig
ø o slash &oslash
¿ inverted ? &#191
¡ inverted ! &#161
¬ not sign &#172
√ check (check)
ƒ function &#131
≈ approx equal ~
∆ Delta &#144
« guillemot left &#171
» guillemot right &#187

… ellipses (three dots) ...
em space

À A grave &Agrave
Ã A tilde &Atilde
Õ O tilde &Otilde
Œ OE ligature &#140
œ oe ligature &#156
– soft hyphen &#173
— long (em) dash --
“ typesetter’s double open quote "
” typesetter’s double close quote "
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Appendix C: Online Reference Site Map

Legalese

Technical Support

BeyondPress 3.0: Introduction

New Features

BeyondPress Documentation

BeyondPress Terms

Features

Introduction

Web Authoring Document Conversion

Features Introduction
BeyondPress Features Introduction 

Document Content Palette
Document Content Palette:
Introduction

Document Content Buttons

Content List Icons

Working with Content List

Elements Palette
Elements Palette: Introduction

Image Pane of the Elements Palette

HTML Pane of the Elements Palette

Media Pane of the Elements Palette

Attributes Inspector
Attributes Inspector: Introduction

Text Box Settings of the Attributes
Inspector

Image Settings of the Attributes
Inspector

Web Page Settings of the Attributes
Inspector

Applet Settings of the Attributes
Inspector

Embed Settings of the Attributes
Inspector

Authoring Introduction
Web Authoring: Introduction

Layout
Web Page Layout

Document Content Palette:
Authoring Mode

Setting Layout Preferences

Background Colors and Images

Adding Headers, Footers, and Meta
Tags

Adding a Date and Time Stamp

Text
Adding Text to Web Pages

Cascading Style Sheets and Font
Name Tags

Working with TrueDoc

Mapping Style Sheets

Creating Master Styles

Editing and Using Master Sheets

Mapping Font Sizes

Link Text Attributes

Converting Text to an Image

Image
Adding Images to Web Pages

Setting Image Preferences, Part I

Setting Image Preferences, Part II

Specifying Image Format and Color 
Palette

Conversion Introduction
Converting QuarkXPress Documents
to Web Pages: Overview

Converting QuarkXPress Documents
to Web Pages: Introduction

Document Content Palette
Setting List Document Preferences

Creating a Content List

Anchoring Text and Images

Adding New Elements to a Web
Page

Segmenting a Text Chain

Deleting Elements and Suppressing
Output

Layout
Web Page Layout

Background Colors and Images

Adding Headers, Footers, and Meta
Tags

Adding a Date and Time Stamp

Overriding Web Page Preferences

Text
Formatting Text

Cascading Style Sheets

Working with True Doc

Mapping Style Sheets 

Creating Master Styles

Editing and Using Master Styles
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Preferences
BeyondPress Preferences
Introduction

Setting Preferences

Application Preferences

Export Preferences

Layout Preferences

Web Page Preferences

Font Names Preferences

Media Preferences

Site Preferences

Mapping Preferences

Font Size Preferences

Styles Preferences

Image Preferences

Table Preferences

List Preferences 

About BeyondPress Panel

Export Progress Window
Export Progress Window

Export Error Messages

Drag and Drop
Drag and Drop

Apple Events Support
Apple Events Support

Character Mapping Table
Character Mapping Table

Image  (continued)
Changing the Transparency of GIFs

Specifying HTML Tags and
Replacement Text

Importing and Using JPEG and GIF
Files

Multimedia
Adding Multimedia to Web Pages

Setting Media Preferences

Multimedia Sources on the Web

Custom HTML
Adding Custom HTML Items

Creating Custom and Master HTML
Elements

Editing or Deleting Master Elements

Using Master and Custom Elements

Using Master Elements as Headers,
Footers, or Meta Tags

Links and Image Maps
Creating Hyperlinks and Image
Maps

Setting Site Preferences

Creating a Link Within a Web Page

Creating an External Link

Creating an Image Map

Editing Links on Image Maps

Previewing Links

Viewing Web Page Links in
QuarkXPress

Previewing and Exporting
Previewing and Exporting:
Introduction

Setting Preferences for Exporting

Exporting a Web Page

Preparing a Template for Exporting
Web Pages

Text  (continued)
Overriding Style Sheet Mapping

Mapping Font Sizes

Link Text Attributes

Converting Text to an Image

Image
Adding Images to Web Pages

Setting Image Preferences, Part I

Setting Image Preferences, Part II

Specifying Image Format and Color 
Palette

Changing Image Format and Color
Palettes

Controlling Size, Scale and
Cropping

Controlling Text Runaround and
Applying Borders

Changing Text Runaround and
Borders

Changing the Transparency of GIFs

Specifying HTML Tags and
Replacement Text

Importing and Using JPEG and GIF

Files

Multimedia
Adding Multimedia to Web Pages

Setting Media Preferences

Multimedia Sources on the Web

Custom HTML
Adding Custom HTML Items

Creating Master and Custom
Elements

Editing or Deleting Master Elements

Using Master and Custom Elements

Modifying Master and Custom
Elements

Using Master Elements as Headers,

Footers, or Meta Tags
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Links and Image Maps
Creating Hyperlinks and Image
Maps

Setting Site Preferences

Creating a Link within a Web Page

Creating an External Link

Creating an Image Map

Editing Links on Image Maps

Previewing Links

Viewing Web Page Links in
QuarkXPress

Tables and Lists
Creating Tables and Lists

Specifying Default Formatting for
Tables

Converting Text to a Table

Specifying Default Formatting for
Lists, Part I

Specifying Default Formatting for
Lists, Part II

Converting Text to a List, Part I

Converting Text to a List, Part II

Preview and Export
Previewing and Exporting:
Introduction

Setting Preferences for Exporting

Exporting a Web Page

Preparing a Template for Exporting
Web Pages
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defined   14
feature summary   8
tutorial   79-92
working with   22

Conversion Mode
described   21
how to access   21
icons, defined   23
overview   12
tab of Document Conversion palette   21
tutorial   79-92
Which mode—Authoring or Conversion?   15

Colors
specifying   41

Copy Original
about   
setting   28

Custom Element
creating   25
defined   14
using   25

D
Date   

adding to document  25 
format   39

Destination Platform, specifying   39
DHTML/CSS  

as default   9
browsers supporting   8 
described   8
using/specifiying   40

Document Content palette
Authoring tab   19
Conversion tab   21
described   18
how to access   18
Keyboard shortcut   93
Key command, changing   93
overview   12
Which mode—Authoring or Conversion?   15

Document Conve rsion   see also: C o nve rsion Mode
described   21
feature summary   8

Documentation
described   10
How to Use   10-11

Drag and Drop   52
feature summary   8
using   65, 68, 73 

A
About BeyondPress 

Feature Summary   8  
Overview   12
What is BeyondPress?   7

Apple Events   52  
Adding a Scripts menu in QuarkXPress   53
described   52
on Application preferences tab  38
setting preferences   38

AppleScript   52   see also: Apple Events
Application Preferences   38
Attributes Inspector

Applet Settings   30
described   27
Embed Settings   31
Feature Summary   8
Keyboard shortcut   93
Key command, changing   93
palette   27
Web Page Settings   27
Image Settings   28
Text Box  Settings   29

Authoring Mode
described   19
how to access   19
overview   12
tab of Document Content palette   19
tutorial   54-62, 63-78
Which mode—Authoring or Conversion?   15

Auto Link URLs   53

B
Background of Web page

setting default   
changing   27

Bitstream TrueDoc Font technology   8
Browser

included with BeyondPress   5, 6
selecting   38
specifying   38, 54-55
support for DHTML

C
Cascading Style Sheets

about   8
settings   39

Character Mapping Table   94
Content Element

defined   14
Content List   21
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L
Layout Preferences   40
Link Editor   32
Links

attributes   27
creating   19, 32  

List Preferences   51

M
Mapping Preferences   46
Master Element

creating   25
defined   14

Master Styles
creating   48
defined   14

Media Preferences   44
Meta Tags

creating  25 
defined   14
selecting   41

Multimedia
adding, in Authoring mode   26
adding, in Conversion mode   
feature summary   8
preferences   44

O
Online Help

accessing   11, 36
described   11

Open in Browser button   77, 92

P
Web Server Platform, specifying   39
Preferences   36

appending   37 
Application   38 
Export   39
Font Names   43
Font Size   47
xxx   nn, nn, nn-nn
how to access   36
Image   50
importing   37
Keyboard shortcut   93
Key command, changing   93
Layout   40
List   51
Mapping   46
Media   44
Site   45
Styles   48
Web Page   41

E
Elements palette   See: Shared Elements palette
Errors   33, 34   See: Export Errors
Export Errors   33, 34

Fatal   34
Non-fatal   35
Text   35

Export Preferences   39
Export Progress Window  33   see also: Exporting

feature summary   8
Exporting

Export Window   33
tutorial   61-62, 75-78, 91-92

Extensis
How to contact   6, 11

F
Feature Summary   8
Font Names Preferences   43
Font Size Preferences   47
Fonts, True Doc See: TrueDoc Fonts

H
HTML Browser   38   see also: Browser
HTML

custom, creating   25
limitations   9, 20
Master Elements   25
tab, of Shared Elements palette 25

I
Image Maps

preferences   49
support for   8

Image Preferences   49
Images

adding, in Authoring mode   24, 64-70
adding, in Conversion mode   24, 80-89
feature summary   8
preferences   44, 49

Import
Master Elements   25
Preferences   37

J
Java

adding to page   30
Applets   30
JavaScript, and links   32
support for   8
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Preview
described   
using   59, 83 

Problem Report    33   see also: Export Progress

Q
QuarkXPress

BeyondPress menus in v3.32   18
version required   5, 6

QuickTime movies
adding to page   31
Embed Settings   31
support for   8

R
RealAudio

adding to page   31
Embed Settings   31
support for   8

Registration   6
Revert Panel button, defined   38

S
Shared Elements palette   23

Image tab   24
HTML tab   25
Media tab   26

Shared Images
defined   14

Shockwave
adding to page   31
Embed Settings   31
support for   8

Site Map   96
Site Preferences   45
Software Requirements   5
Style Preferences   48
Suggestions   7
System Requirements   5

T
Table Preferences   50
Tasks

for Authoring mode   15-16
for Conversion mode   16-17

Technical Support   6
Terms   14
Time   

adding to document  25 
format   39

Tools   18-52

TrueDoc Fonts
about   8
specifying location of   45

Tutorials
Building a Web Site   63-78
Creating a Web Page   54-62
Using Conversion Mode   79-92

U
URL

Create Relative   39
specifying   45   

W
Web Authoring   See: Authoring Mode
Web Pages   

defined   14
Web Page Preferences   41


